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Introduction
This chapter contains resources and notices that are pertinent to the DEFINITY 
Network Management (DNM) products. 

The DEFINITY Network Management CD-ROMs section lists the contents of the 
product CD-ROMs that are delivered to customers.

The Lucent Resources section describes the services that are available from the 
Sales and Design Support Center (SDSC), NetCare Professional Services (NPS), 
and Technical Services Center (TSC). 

The References section contains Lucent contact information, including web sites, 
phone numbers, and email addresses. The section also contains contact 
information for third-party vendors.

The System Security section defines the precautions that customers must take 
to maintain the security of their networks and systems. The section also contains 
information on toll fraud security.

The Year 2000 Compliance section contains the Lucent policy to meet the year 
2000 requirements for the manufacture and sales of its products after September 
26, 1996.
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DEFINITY Network Management CD-ROMs
Lucent Technologies delivers the DEFINITY Network Management (DNM) 
products and the user documentation to customers on two separate CD-ROMs, 
which are entitled:

• DEFINITY Network Management for UNIX

• DEFINITY Network Management Proxy Agent 

The contents of each of the CD-ROMs are listed below:

DEFINITY Network Management Release 3.0 for UNIX

• Product software and Versant database

• DNM Online Help System integrated in the product software

• DNM User Documentation for UNIX, Installation and Getting Started

• PA001 Administration Request form 

DEFINITY Network Management Proxy Agent Release 3.0

• Proxy Agent software

• Proxy Agent User Documentation for Installation and Administration

• PA001 Administration Request form 

You should print the documentation and PA001 forms directly from the CD-ROM 
before they install the DNM software.
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Lucent Resources
Lucent Technologies provides customers with a variety of planning, consulting, 
and technical services. 

The account executives are the customers’ primary source to obtain information 
and explore custom options to meet their specific business needs. 

Note: The DEFINITY Network Management products are a software-only offer. 
Therefore, customers are solely responsible for the purchase and 
maintenance of all third-party hardware and software that are required to 
run the DEFINITY Network Management products.

The DEFINITY Solutions web site contains the system requirements and other 
provisioning and connectivity information for the DNM products. Refer to "Lucent 
References" on page 17 for the web address.

The sections below briefly describe the resources and services that are available 
to customers.
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Sales and Design Support Center (SDSC)
The Sales and Design Support Center (SDSC) works with customers and account 
teams to develop detailed solutions for connectivity to the DEFINITY and other 
supported systems. The SDSC also designs network configurations to support the 
DEFINITY Network Management products. 

NetCare Professional Services (NPS)
NetCare Professional Services (NCG) is available to work with customers to 
design and build a turn-key network management system. 

NetCare offers the consulting services listed below:

• Plan and design a custom network system

• Purchase and configure SCO-certified hardware and external devices for the 
Proxy Agent computer and the Network Management System (NMS) 
platforms

• Install and set up the UnixWare Operating System

• Connect and administer all devices, ports, and cards

• Install and integrate the DEFINITY Network Management products on the 
NMS platform

• Train users on the operation and management of the products
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Technical Services Center (TSC)
The Technical Services Center (TSC) provides support for the DEFINITY Network 
Management products to account teams, field technicians, and customers. 

The TSC works with the customer and the Lucent field technicians to perform the 
tasks below and to ensure that the products are properly installed and working:

• Platform Acceptance Test from the Proxy Agent computer

• Installation Support for the DEFINITY Network Management products

• Technician Verification checklist 

• Customer Acceptance checklist 

Time and 
materials 
charges

The Technical Services Center (TSC) will bill customers for support on a time and 
materials basis if the following conditions exist:

• Customers do not have a current maintenance agreement

• Customers do not procure and install the required systems and software as 
defined in the Project Provisioning Package

• Customers request support that is outside the purchase agreement

The Technical Services Center (TSC) does not support hardware or software that 
customers purchase from third-party vendors.
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References
This section contains references to web sites, phone numbers, and email 
addresses for Lucent Technologies and third-party vendors. 

The contact information is listed in the sections below:

• "Lucent References" on page 17

• "Vendor References" on page 20

Customers can access web sites that are outside the Lucent fire wall.

! CAUTION:
The owners of the web sites may change the universal resource location (URL) 
for a specific web site address without notice. The reference information will be 
updated with each new release of the DEFINITY Network Management products.
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Lucent References
The table below contains Lucent web sites, phone numbers, and email addresses 
for various sources. Some of the web sites are inside the firewall and are not 
accessible to customers. 

Table 1. Lucent Resource sites

Source Web Sites

DEFINITY Solutions Systems Management site:

http://www.bcs.lucent.com/salesmarket/definity/sys
mgmt

Toll Fraud Intervention 1-800-643-2353

IntraWorks Catalog DEFINITY Network Management User Document 
Set:
http://www.lucent.com/enterprise/documentation

 (1 of 2)
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NetCare Professional 
Services (NPS)

Email: dnmconsulting@lucent.com

Consulting offer:
http://www.netcaredata.com/solutions/consult.shtml

Technical Services Center 
(TSC)

Technical Support: 1-800-242-2121, ext. 8-6767

Fax for PA001 form: 1-303-804-3367

Connectivity Guide:

http://www.dc.tsc.bcs.lucent.com/html/table1/htm 

Tier IV Support Registry International Customer only:

Fax for PAOO1 form: (U.S. code) 303-538-5506

Table 1. Lucent Resource sites

Source Web Sites

 (2 of 2)
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Table 2. Lucent Resource sites INSIDE firewall

Project Development Team

R&D Bell Labs

DEFINITY Network Management (DNM) internal 
web site:
http://info.dr.lucent.com/defnm

Documentation and 
Training Information 
Development

DNM 3.0 project web site:

http://pubnet.lucent.com/project/dnm3_0.htm 

DEFINITY Enterprise 
Management Support

http://dfmpa1.dr.lucent.com 

Project Provisioning 
Package

http://dfmpa1.dr.lucent.com/docs/snmpppp30.doc

Sales and Design Support 
Center (SDSC)

Phone: 1-888-297-4700, prompt 6

Main site (requires a password): 
http://www.bcs.lucent.com/tech_info/sdsc
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Vendor References
The table below contains the web sites for third-party vendors. 

Table 3. Vendor web sites

Vendor Web Sites

AIX AIX patches: 
http://service.software.ibm.com/support/rs6000

Computone I/O cards Main site: http://www.computone.com

Equinox Main site: http://www.equinox.com

Hewlett Packard Main site: http://www.hp.com

OpenView site: http://www.openview.hp.com

IBM Main site: http://www.ibm.com

Microport Main site: http://www.mport.com

Microsoft Main site: http://www.microsoft.com

Remedy ARS Main site: http://www.remedy.com

Santa Cruz Organization, 
Inc. (SCO)

Main site: http://www.sco.com

UnixWare certified hardware: 
http://wdb1.sco.com/chwp/owa/hch_search/form

Upgrade patch: ftp://ftp.sco.com/UW21

 (1 of 2)
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Sun Microsystems, Inc. Main site: http://www.sun.com

Solutions site: http://sunsolve.sun.com

Telamon TelAlert Main site: http://www.telamon.com

Tivoli Main site: http://www.tivoli.com

Versant Main site: http://www.versant.com

Table 3. Vendor web sites

Vendor Web Sites

 (2 of 2)
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System Security Notices
Customers are solely responsible for the security of their system, network, and 
access to hardware and software.

The sections below define the precautions that all customers should take to 
maintain the security of their systems.

Network Security
The DEFINITY Network Management products use the standard security features 
on the UNIX and NT operating systems. 

Lucent strongly recommends that customers use passwords to prohibit access to 
their systems and to routinely change those passwords to maintain security. 

! SECURITY ALERT:
Customers should always change passwords immediately after external 
vendors have completed installation, maintenance, troubleshooting, or 
other tasks on their system.
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Toll Fraud Security

Although the DEFINITY Network Management products are generally not at risk 
for toll fraud, customers are solely responsible for the security of their entire 
telecommunications systems. 

Toll Fraud is the unauthorized use of a company’s telecommunications system by 
unauthorized parties. Unauthorized parties are persons other than the company’s 
employees, agents, subcontractors, or persons working behalf of on the company.

Note: Toll fraud can result in substantial additional charges for the company’s 
telecommunications services.

The company’s system manager is responsible for the security of the company’s 
system, which includes programming and configuring the equipment to prevent 
unauthorized use.

Lucent 
Disclaimer

Lucent Technologies does not warrant that this product is immune from or will 
prevent unauthorized use of common-carrier telecommunications services or 
facilities accessed through or connected to it. Lucent Technologies will not be 
responsible for any charges that result from such unauthorized use. .

Lucent Fraud 
Intervention

If customers suspect that they are a victims of toll fraud and need technical 
assistance, customers should refer to the "Lucent References" on page 17 for the 
Toll Fraud Intervention phone number. 
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Year 2000 Compliance Notice
The Business Communication System (BCS) part of Lucent Technologies makes 
the following statement with respect to any product manufactured and sold by 
Lucent BCS in connection with a product’s operation in the year 2000. 

Any product or version/release of a product that is introduced as generally 
available on or after September 30, 1996, will be year 2000 compliant or Lucent 
BCS will make it year 2000 compliant at our cost.

Any other product, depending on the specific product and its release or version, 
will fit into one of the following categories:

• The product is year 2000 compliant.

• If the product is not year 2000 compliant, Lucent BCS will provide an upgrade 
path to a generally available release that is year 2000 compliant at a 
reasonable cost to the customer; or

• If the product is not year 2000 compliant, and no upgrade path to a generally 
available release that is year 2000 compliant is available, Lucent BCS will 
evaluate whether there are potential modifications to the product that will 
make it year 2000 compliant, and if Lucent BCS determines that such 
modifications are economically practical, Lucent BCS will offer such 
modifications to the customer at a reasonable cost; or

• If the product is not year 2000 compliant, and if Lucent BCS determines that it 
is not economically practical to make the product year 2000 compliant, Lucent 
BCS will inform the customer of this fact and offer migration options at a 
reasonable cost.
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Introduction
This chapter contains an overview of the primary features in the DEFINITY 
Network Management Release 3.0 for UNIX and pertinent information on the 
topics listed below:

• New features

• Supported systems

• System requirements for NMS platforms and software

In addition, this chapter describes the target audiences for DEFINITY Network 
Management Release 3.0 for UNIX User Documentation Installation and Getting 
Started and outlines the organization of this book.

Software-only 
offer

The DEFINITY Network Management and Proxy Agent products are software 
only offer. Lucent Technologies is soley responsible for the support and 
maintenance of the product software.

Customers are soley responsible for the purchase, support, and maintenance of 
third-party hardware and software products that are required for this offer.
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Product Overview
The DEFINITY Network Management (DNM) product and the DNM Proxy Agent 
provide a complete solution to manage network resources from a central point of 
entry. 

These products provide users with a view of the health and performance of their 
network systems.The DEFINITY Network Management and Proxy Agent products 
work together as an integrated application. 

Proxy Agent 
product

The DEFINITY Network Management Proxy Agent is a protocol conversion 
resource. The Proxy Agent software resides on a stand-alone personal computer 
and operates on the SCO UnixWare Operating System available from Microport.

The Proxy Agent uses serial ports to collect configuration and management data 
from supported systems. The Proxy Agent converts the data into the Simple 
Network Management Protocol (SNMP). 

In addition, the Proxy Agent generates SNMP traps when supported systems 
generate alarms.

The Proxy Agent then communicates the SNMP data to the DEFINITY Network 
Management (DNM) product that resides on the Network Management System 
(NMS) network server. The NMS network server can be either a UNIX system or a 
Windows NT system. 
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DNM product The DEFINITY Network Management (DNM) product provides users with 
graphical and tabular tools to monitor the status and performance of a network of 
supported systems and external devices. 

The DNM product collects configuration, fault, and performance data from the 
Proxy Agent via Simple Network Management Protocol (SNMP) and displays the 
data in text, tables, and graphic formats.

The primary features of the DEFINITY Network Management product include:

• Graphical User Interface (GUI) -- The DNM main window contains a 
navigation tree that lists all the supported system and displays a colored alert 
symbol that indicates highest exception level. Users can expand the list to 
view all of the configuration components and specific alert symbols for each 
component.

• Configuration -- Users can view the configuration and administered 
properties of all supported systems (managed nodes) in both a graphic view 
and a table view.

• Administration -- Users define the system-wide parameters for the features 
below:

– Data collection -- Users define the parameters for the data to be 
collected from each system, including the type of data, the schedule for 
collecting data, and the length of time to store the data.

– Exception logging -- Users define the conditions to log exceptions for 
performance thresholds, faults, and system errors.
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– Exception alerting -- Users specify the alert levels for exceptions from 
each supported system. Alerts levels may include exceptions that are 
critical, major, minor, or warning. The alert level and location of the 
exception display in the main window as long as the exception exits.

• Report Manager -- Users can define the parameters for individual reports for 
all or selected systems. The report options include:

– Performance 

– Configuration

– Exceptions 

Users can immediately view the reports on screen in both the table and chart 
formats or direct the output of reports to a printer or to an HTML or ASCII file.

– Scheduled Reports -- Users can schedule reports to run on a daily, 
weekly, or monthly basis, and edit and delete schedules as needed.

The DEFINITY Network Management product runs on the network server 
platforms below that are required for the current release:

• HP OpenView that runs on Sun Solaris or HP-UX 

• Tivoli TME 10 NetView that runs on AIX

NMSI program The Network Management System Integration (NMSI) program is one of the 
programs in the DEFINITY Network Management (DNM) software. The purpose 
of NMSI is to integrate the DNM product into the OpenView and NetView 
operating systems.

This integration allows users to monitor their Lucent telecommunication systems 
and data networks from the same workstation. 
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NMS maps NMSI uses the Auto-Discovery program to find managed nodes (supported 
systems). 

The NMSI uses the data received from Auto-Discovery to create and update the 
NMS maps, which include:

• NMS Root map

• DEFINITY map

• DEFINITY USA and State maps

• Custom maps 
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Network 
configuration

The figure below shows an example of the network configuration between a 
DEFINITY system, the Proxy Agent computer, and an NMS network server. 

Figure 1. Network configuration
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1 DEFINITY system 
2 Netcon channel or system access 

ports on the DEFINITY system
3 Dial-up connection between 

DEFINITY system and the Proxy 
Agent modem

4 Proxy Agent stand-alone computer 
and Proxy Agent product

5 Internet TCP/IP connection (LAN 
or WAN) between the Proxy Agent 
and the NMS server 

6 UNIX Network server where the 
DEFINITY Network Management (DNM) 
product resides. The server can be one 
of the platforms listed below

• OpenView that runs on Sun Solaris 
or HP-UX;

• NetView that runs on AIX 
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New Features
This section contains a brief description of the new features, improvements, and 
changes to DEFINITY Network Management for release 3.0. 

• Support for the SNMP traps and alarm traps from the systems listed below:

– DEFINITY releases 7.1 and 8.1, including Survivable Remote Processors 
(SRPs)

– Multipoint Conferencing Unit (MCU) release 6.0

• Support for alarm traps from the systems listed below:

– DEFINITY Audix release 4.0

– INTUITY Audix releases 4.4 and 5.0

– INTUITY Interchange releases 5.2 and 5.3

– Call Management System (CMS) R3V8

– Conversant release 7.0

• New system architecture that consolidates Fault and Performance 
Management into one DNM product

• Revised the applications listed below:

– Added a new DNM Main window and navigation tree

– Added graphic and table views to the Configuration application

– Revised the Administration application

– Revised the Report Manager application

– Revised the Task Scheduler application

• Added support for the Windows NT platform
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• Added the user documentation listed below to the DEFINITY Network 
Management CD-ROMs for UNIX and NT: 

– User Documentation for UNIX, Installation and Getting Started

– User Documentation for NT, Installation and Getting Started

– PA001 Administration Request forms

• Revised PA001 Administration Request forms (Rev. 12/99) to reflect the data 
that users enter at the installation prompts. For security reasons, the PA001 
forms do not contain login and passwords data.
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Supported Systems
DEFINITY Network Management Release 3.0 supports both SNMP traps and 
alarm traps for the systems listed below:

• DEFINITY PBX release 4.0 and DEFINITY ECS releases 5.0 through 8.1

• Survivable Remote Processors (SRPs)

• Multipoint Conferencing Unit (MCU) release 6.0. 

DNM treats SRPs and MCUs as DEFINITY systems.

DEFINITY Network Management Release 3.0 supports only alarm traps from the 
systems listed below:

• DEFINITY Audix releases 3.1 through 4.0

• INTUITY Audix release 4.3 through 5.0 (with or without the remote 
maintenance board)

• INTUITY Interchange release 5.1 through 5.3

• Call Management System (CMS) R3V6 through R3V8

• Conversant release 7.0
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System Requirements
The sections below outline the hardware and software products that are required 
for DEFINITY Network Management Release 3.0 for UNIX.

NMS Platform Requirements
DEFINITY Network Management Release 3.0 for UNIX operates on the Network 
Management System (NMS) platforms below:

• HP OpenView releases 5.0 and 6.0 that run on

– Sun Solaris release 2.6 or 

– HP-UX release 11.0

• Tivoli TME 10 NetView release 5.1 that runs on AIX release 4.3

• DNM Proxy Agent Release 3.0

Customers should work with their Lucent account team to determine the hardware 
requirements that meet their business and performance specifications. 

The Lucent account team uses the DOSS Configurator to configure the hardware 
requirements for the Network Management System (NMS) platforms. 

! CAUTION:
Customers are solely responsible for upgrading their network platforms to meet 
the NMS platform requirements for DEFINITY Network Management Release 3.0 
for UNIX. 
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Overview of the User Documentation
The sections below briefly outline the chapter contents in DEFINITY Network 
Management Release 3.0 for UNIX User Documentation Installation and Getting 
Started (this book). 

The individual chapters provide the essential information to install, administer, and 
get started on the DNM product. The chapters contain screen layouts, field 
descriptions, and step-by-step procedures.

Target Audiences 
The target audiences for the User Documentation include both technical users 
and general users at all levels.  

• System administrators

• Network managers

• Technical Services Center engineers

• Lucent field technicians and installers

• Lucent consulting groups, NetCare, SDSC, and others

• Lucent account executives and project teams

• Global Services Organization and local support vendors for international 
customers
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All users need to have working knowledge of the hardware and software listed 
below: 

• UNIX systems

• SCO UnixWare Operating System

• Network Management Systems (NMS) platforms, OpenView and NetView

• Hardware connectivity

• Software installation and integration

In addition, the User Documentation is an essential resource for users who are 
unfamiliar with the purpose and operation of the DEFINITY Network Management 
product.

Customer Pre-Installation Tasks
The information in Chapter 2, "Customer Pre-Installation Checklist" outlines the 
tasks that customers must complete prior to the installation of the DNM-UNIX. 

The pre-installation tasks also include the platform patches that customers must 
install on the NMS network server.
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UNIX Installation
The information in Chapter 2, "UNIX Installation" contain the essential checklists 
to install DNM on UNIX and post installation checklists to ensure the system is 
functioning properly. 

The chapter contains the procedures to install a new DNM product and to upgrade 
earlier releases of the DNM product. 

This chapter also contains the procedures to:

• Backup and restore the current database

• Execute Auto-Discovery 

• Remove the DNM-UNIX product

System Administration
The information in Chapter 3, "System Administration" allows system 
administrators to manage the options below:

• Control the NMSI polling of Proxy Agents

• Override the default location submaps that are administered on the Proxy 
Agent

• Execute system commands to start and stop the DNM product and to view the 
system health status

• Execute database commands

• Edit system configuration files to customize the DNM product

• Integrate third-party products for alarm notification

• Install the Auto-Discovery patch on Trouble Trackers 
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Getting Started on DNM for UNIX
The information in Chapter 4, "Getting Started on DNM for UNIX" contains the 
login procedure and briefly outlines the features in Network Management System 
(NMS) and the DEFINITY Network Management (DNM) product.

The chapter includes the sections below:

• Log in and exit DNM 

• Description of the NMS map, including color schemes for system icons and 
connections lines

• Execute commands from the NMS maps 

• Description of the DNM product 

• Description of the online help system 

• Description of the DNM main window and navigation tree 

• Description of the Configuration window 

• Description of the Report Manager 

• Description of the Task Scheduler 

• Description of the Administration window 
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Introduction
This chapter contains the procedures to install the DEFINITY Network 
Management Release 3.0 product as a new or upgrade installation.

Pre-installation 
tasks

Customers must complete all of the pre-installation tasks before the new 
DEFINITY Network Management (DNM) product can be installed or upgraded. 
Refer to chapter 2, "Customer Pre-Installation Checklist" on page 43.

Installation 
checklists

The section entitled "Customer Pre-Installation Checklist" on page 43 contain the 
checklists below: 

• The installer completes the Installation Tasks Checklist during the 
installation. 

• The installer and the TSC complete Technical Verification Checklist after 
the installation.

• The TSC and the customer complete Customer Acceptance Checklist after 
the installation.

Installation 
prompts

The section entitled "Installation Prompts" on page 51 explains the prompts that 
the installation script displays during the installation process. 

Users must enter the requested information. The completed PA001 should 
contain the information requested by the installation prompts.



DNM-UNIX Release 3.0 User Documentation    

2 UNIX Installation
Introduction

March 2000
Page 42

Installation 
procedures

The installation procedures are divided into separate sections for either a new 
installation or an upgrade to the current release:

• For a new installation, refer to "Install the New DNM Product" on page 55 

• For an upgrade installation, refer to one of the sections below that matches 
the release number of the product currently installed:

– "Upgrade DNM 2.0.1 and Later" on page 62 

– "Upgrade Fault Management 1.4 and Earlier" on page 71 

User 
documentation

The installation script for this release automatically copies the DEFINITY Network 
Management User Documentation for UNIX to the lucntdoc directory. 

Users can access the Lucent Technologies Documentation (this book) and the 
PA001 forms from either the OpenView Fault menu or the NetView Monitor 
menu. 

Online help 
system

The new online help system is integrated in the DEFINITY Network Management 
3.0 product. 

User can access the help system from any screen in DNM or from the Help option 
on the menu bar. 



DNM-UNIX Release 3.0 User Documentation    

2 UNIX Installation
Customer Pre-Installation Checklist

March 2000
Page 43

Customer Pre-Installation Checklist
Customers must complete all the tasks listed in the pre-installation checklist below 
before the DEFINITY Network Management product can be installed.

1 Install or upgrade the Network Management System (NMS) platform and 
operating system on the network. Refer to "NMS Platform Requirements" on 
page 35 and the vendor documentation.

2 Install the patches for the Solaris or HP-UX platforms. Install the patches 
before installing the DEFINITY Network Management product on the NMS 
platform. Refer to "Operating System Patches" on page 44. 

3 Check with vendors to make sure you have the latest recommended patch set 
for Open view/ Net view.

4 Connect the Proxy Agent serial connection to the managed nodes. 

5 Connect the Proxy Agent TCP/IP connection to the Network Management 
System (NMS) through the local area network (LAN) or the wide area network 
(WAN). Refer to the vendor documentation.

6 Verify that the updated PA001 Administration Request form (Rev. 12/99) is 
completed and faxed to the Technical Services Center (TSC) or International 
Technical Assistance Center (ITAC). 

Note: After the DNM installation, system administrators can execute the 
appropriate tasks in Chapter 3, "System Administration". 
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Operating System Patches 
Customers must install the platform patches before they install or upgrade the 
DEFINITY Network Management product. The software programs require these 
patches to enable the JAVA multi-threaded environment.

! CAUTION:
See your vendor to ensure the latest Y2K compliant patch for your operating 
system is installed.

The CD-ROM entitled, DEFINITY Network Management Release 3.0 contains 
the patches for the Solaris and HP-UX platforms. These patches are in 
compressed tar format: 

• Solaris 2.6

105490-07

• HP-UX 11.x

PHCO_17792

PHCO_19491

PHKL_14750

PHKL_17038

PHKL_17935

PHKL_18543

PHKL_19800

PHKL_19942
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PHNE_17586

PHNE_18878

PHNE_19037

PHSS_15853

PHSS_17535

PHSS_18430

PHSS_19593

PHSS_19748

bundle: Y2K-1100

Customers can install the patches that come with the DEFINITY Network 
Management product. However, these patches may not be the current version for 
the platform.

Therefore, we recommend that customers download the current versions of the 
platform patches from the vendor web site, rather than install the patches from the 
DEFINITY Network Management CD-ROM. Refer to "Vendor References" on 
page 20. 

! CAUTION:
The platform patches are the property of the vendor. Therefore, customers must 
contact their vendor representative for support.

See also For procedures to install patches, refer to the systems administrator’s guide for 
the appropriate NMS platform.
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Installation Checklists
The installation checklists contain the tasks that installation technicians must 
complete to install the DEFINITY Network Management product. 

The "Installation Tasks Checklist" on page 47 contains the tasks that installers 
must execute during the installation process.

The "Technical Verification Checklist" on page 49 contains the post installation 
tasks that the installation technician and the engineer at the Technical Services 
Center (TSC) must complete to insure that the Proxy Agent is properly 
administered and functioning.

The "Customer Acceptance Checklist" on page 50 contains the post installation 
tasks that the engineer at the TSC and the customer must complete to insure the 
that customer can operate the Proxy Agent and accepts the installation as 
complete.

The checklists only contain references to procedures. If installers are unfamiliar 
with the DEFINITY Network Management applications, then they should read the 
introduction sections that precede the procedures.
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Installation Tasks Checklist
Users should complete the installation tasks in the order presented below. 

1 Verify that the customer has completed the pre-installation tasks and installed 
the current versions of the Solaris or HP-UX patches. Refer to "Customer 
Pre-Installation Checklist" on page 43.

2 Assemble the required materials and information, including:

• Root name and password

• Directory path for the file or archive device to backup the database for an 
upgrade installation

• Directory path for the Adobe Acrobat Reader if the reader is already 
installed

• Completed PA001 form

• CD-ROMs DEFINITY Network Management Release 3.0 for UNIX

• Printed copy of the DNM 3.0 for UNIX User Documentation (this book)

• Technical Services Center (TSC) number: 1-800-242-2121, ext. 8-6767 

Note: To upgrade DNM 2.0 and later, users can either backup the database 
before they install DNM 3.0 or during the installation of DNM 3.0. 

In either event, users should restore the database after the installation. 
Refer to "Backup and Restore the Database" on page 78.
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3 Complete the appropriate installation procedure: 

• "Install the New DNM Product" on page 55 

• "Upgrade DNM 2.0.1 and Later" on page 62 

If users backed up the existing database, then execute the restore 
command in the procedure to "Backup and Restore the Database" on 
page 78 

• "Upgrade Fault Management 1.4 and Earlier" on page 71 

4 If problems occur, refer to "Installation Error Messages" on page 76. 

5 Complete the procedures to "Execute Auto-Discovery" on page 81. 

6 If problems occur, refer to "Auto-Discovery Errors and Problems" on page 86. 

7 Verify that the DNM installation and the NMS integration were successful. 
Refer to the sections below in the Chapter 4, "Getting Started on DNM for 
UNIX": 

• "Description of the NMS Maps" on page 126 

• "Execute Commands from NMS Maps" on page 145 

Note: After the DNM-UNIX installation, system administrators or root users can 
execute the tasks in Chapter 3, "System Administration".
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Technical Verification Checklist
At the completion of the DNM installation, the engineer at the Technical Services 
Center (TSC) validates the tasks on the Technical Verification Checklist below: 

1 Verify that the customer completed and faxed PA001 Administration Request 
form (Rev. 12/99) to the TSC.

2 Verify that the TSC has updated the System Management database with the 
current data from the PA001 form.

3 Verify that Auto-Discovery works on the public or private network. Refer to 
"Execute Auto-Discovery" on page 81 

4 Generate an exception event. Verify the object colors for the exception status 
correctly displays on the root map, submaps, and DEFINITY Network 
Management screens. Refer to "Description of the NMS Maps" on page 126.

5 In addition, check the information below:

• Verify that the Proxy Agent and the NMS can receive alarms from each 
managed node

• Verify that the TSC and the NMS can receive alarms from each managed 
node

6 For Lucent legacy systems that are connected to a Trouble Tracker, telnet to 
the Trouble Tracker and verify the status of the legacy systems. Refer to 
"Execute Commands from NMS Maps" on page 145. 
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Customer Acceptance Checklist
At the completion of the DNM installation, the engineer at the Technical Services 
Center (TSC) works with the customer to complete the tasks on the Customer 
Acceptance Checklist below. 

1 Review the sections in Chapter 3, "System Administration" with the customer.

2 Review the sections in Chapter 4, "Getting Started on DNM for UNIX" with the 
customer.

3 Request the customer to log in to the DEFINITY Network Management 
product and complete the tasks below:

• Access various screens in the applications: Configuration, Administration, 
Report Manager, and Task Scheduler

• Access Help topics for various screens in each application
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Installation Prompts
The installation script for this release has been revised in order to simplify the 
process and to make the installation of the DEFINITY Network Management 
(DNM) product more automatic. 

PA001 form The completed PA001 Administrative Request form contains most of the 
information that is specific to the customer’s system. 

Installers must refer to the various sections on PA001 form in order to enter the 
information that is requested at the installation prompts.

Default options The sections below describe the prompts in the order presented in the installation 
script. 

Lucent strongly recommends that installers select the default options where 
appropriate. 

The default options allow users to maintain consistency when upgrading to new 
releases. The installation script overwrites previous settings during the installation 
process.
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Backup the Database Prompt
The installation script only displays the prompt to back up the database if a 
database already exists. This could be due to an upgrade from DPM 2.0.1 or a 
reinstall of DNM 3.0.

After backing up the database ( or skipping the backup step) you can select 
whether to retain the existing database or to create a new empty database.

Users can either backup the database before they install DNM 3.0 or during the 
installation of DNM 3.0. 

If users backed up the database, then they must restore the database after the 
DNM 3.0 product is installed. Refer to "Backup and Restore the Database" on 
page 78. 

Printer Command Prompt
The Report Manager in the DNM product supports a printer connected to the NMS 
network server. The printer command prompt allows users to either accept the 
default command or enter a different command. 

To respond to the prompt, users should refer to the PA001 form, go to the 
Network Management System (NMS) section, and enter the selected option from 
the Printer Command field.
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Telnet Command Prompt
The DNM products allow access to DEFINITY systems through a telnet session to 
a Proxy Agent. The telnet command prompt allows users to either accept the 
default command or enter a different command.

To respond to the prompt, users should refer to the PA001 form, go to the Network 
Management System (NMS) section, and enter the selected option from the 
Proxy Agent Telnet Command field.

HTML Report Location Prompt
The Report Manager in the DNM product requires a URL to store HTML reports. 
Users can enter one of the options below:

• Accept the default URL

• Enter a URL for a local web server

• Enter a URL for a remote web server

To respond to the prompt, users should refer to the PA001 form, go to the 
Network Management System (NMS) section, and enter the selected option from 
the HTML Report Location field.

Modifications Prompt
For the DNM product to work properly, the installation script must change the 
environment variables in the /etc/profile directory and make CDE modifications 
on the system. 

Users should accept the modifications.
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Adobe Acrobat Reader Prompt
In this release, the installation script copies the user documentation (this book) 
and the blank PA001 forms to the doc subdirectory.

– for Solaris: /opt/lucent/DEFINITY/doc

– for AIX: /usr/lucent/DEFINITY/doc

The installation script prompts for the directory path to install the Adobe Acrobat 
Reader: 

• For a new installations, users select the default directory path to install the 
reader. 

• If the reader is already installed in a different directory, then users must enter 
the directory path where the reader is installed. 

The script for the reader requires users to accept the license agreement and to 
reconfirm the directory were the reader is installed.
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Install the New DNM Product
This section contains the procedure to install a new DEFINITY Network 
Management Release 3.0 for UNIX .

Required 
materials

Users need the following materials and information:

• Root login and password 

• Completed PA001 form

• Adobe Acrobat Reader directory path, if already installed

• CD-ROM entitled, DEFINITY Network Management Release 3.0 for UNIX 

!WARNING:!
Installation of the DEFINITY Network Management software requires a 
system reboot following installation.

Procedure Complete the procedure below to install the new DEFINITY Network 
Management product on the NMS network server. 

1 At the UNIX login prompt, log in as the root user:

• Type [root login]

• Press ENTER

2 At the Password prompt,

• Type [root password]

• Press ENTER
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3 Insert the CD-ROM entitled, DEFINITY Network Management Release 3.0 
for UNIX, into the CD-ROM drive and close the drive.

4 Some operating systems may automatically mount the CD-ROM. To manually 
mount the CD-ROM, at the UNIX prompt, execute one of the options 
(a,b,or c) below: 

a For the SOLARIS platform, the system automatically mounts the 
CD-ROM. If the CD-ROM fails to mount, then

– Type mountall

– Press ENTER

b For the HP-UX platform:

– Type mount  -r /dev/dsk/[device_name] /cdrom

– Press ENTER 

c For the AIX platform:

– Type mount -vcdrfs -r /dev/cd0 /cdrom

– Press ENTER

5 At the UNIX prompt, change to the CD-ROM root directory. i.e. For the 
SOLARIS platform typically: cd /cdrom/cdrom0

6 Change to DNM product directory:

• Type cd DNM

• Press ENTER
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7 At the UNIX prompt, type the INSTALL command exactly as shown below:

• Type ./INSTALL 

• Press ENTER

Result: The system displays the prompt: Do you want to install 
DEFINITY Network Management 3.0 Software? [yes]

8 To install the DNM product,

• Type Y (yes)

• Press ENTER

Result: Installation script displays a message checking patches and kernel 
tunable parameters . This may take several minutes. 

9 Printer Command Prompt. The system displays a message that describes 
the print command. Then the system displays the prompt: 

Enter Printer Command [lp %file].

On the PA001 form, go to the Network Management System (NMS) section 
and refer to the Printer Command field.

At the UNIX prompt, execute one of the options (a or b) from the PA001 form:

a To accept the default printer command, press ENTER 

b To enter the printer command from the PA001 form:

– Type [printer command]

– Press ENTER
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10 Telnet Command Prompt. The system displays a message that describes 
access to a DEFINITY ECS switch through a telnet session to a Proxy Agent. 
When users execute a telnet session from the DNM product, the system 
appends the target host name to the telnet command string. Then the system 
displays the prompt: 

Enter Telnet command [xterm -e telnet]?

On the PA001 form, go to the Network Management System (NMS) section 
and refer to the Proxy Agent Telnet Command field.

Execute one of the options (a or b) below:

a To accept the default telnet command, press ENTER

b To enter a different telnet command, 

– Type the [command]

– Press ENTER

11 HTML Report Location Prompt. The system displays a message that 
describes access by a web browser to the HTML reports. Then the system 
displays the prompt: 

Enter URL [file:///opt/lucent/DEFINITY]?

On the PA001 form, go to the Network Management System (NMS) section 
and refer to the HTML Report Location field.

At the UNIX prompt, execute one of the options (a, b, or c) from the PA001 
form: 

a To accept the default URL, file:///opt/lucent/DEFINITY, press ENTER 

b Enter the URL for a web server from the PA001 form.
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12 Modifications Prompt. The system displays a message that describes the 
environment variables and the required modifications that the installation 
script needs to make.Then the system displays the prompt: 

Make the /etc/profile and CDE modifications? [yes]

To make the modifications, press ENTER

13 Adobe Acrobat Reader Prompt. The system displays a message that the 
user documentation can be viewed by installing the Adobe Acrobat Reader or 
entering the directory if the reader is already installed. Then the system 
displays the prompt: 

Enter Adobe Acrobat Reader directory (leave blank to 
install)

Execute one of the options (a or b) below:

a To install the Acrobat Reader, go to step 14

b If the Acrobat Reader is already installed, then go to step 15

14 To install the Acrobat Reader, execute steps (a through e) below:

a At the prompt, press ENTER

Result: The system displays the prompt: Install default 
configuration, Acrobat Reader 3.01 for [platform 
and release]? [y]

b To continue, press ENTER

Result: The system displays the Adobe Acrobat Reader script NOTICE TO 
USER. At the end of the notice, the system displays the prompt: 
Do you accept the terms and conditions of this 
license agreement?
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c Read the notice. At the prompt,

– Type accept

– Press ENTER

Result: The system installs the Acrobat Reader. Then the system displays 
the confirmation prompt: 

Enter directory where Reader was just installed: 
[/opt/Acrobat3]?

d To confirm the directory, press ENTER

e Then go to step 16

15 If the Acrobat Reader is already installed, then execute steps (a through c) 
below:

a Enter the directory path where the Acrobat Reader resides:

– Type [directory path]

– Press ENTER

Result: The system displays a confirmation prompt:

Enter directory where Reader is installed: 
[directory path]?

b To confirm the directory, press ENTER

c Then go to step 16
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16 Continue the DNM Installation. The system displays the message and 
prompt: 

All prerequisites have been met, do you want to 
continue with the installation of DEFINITY Network 
Management 3.0 software for [platform and release 
number] [yes]?

To continue the DNM installation, press ENTER

Result: The system displays a series of messages that confirm the 
installation of the software files, database files, web-based reports, 
and the DNM online HELP documentation. This may take several 
minutes. Then the system displays the message: 

Please reboot the system now to complete the 
installation and automatically start the DEFINITY 
Network Management processes.

17 To return to the root (/) directory:

• Type cd /

• Press ENTER

18 Use the eject or umount commands to unmount the CD-ROM:

19 Remove the CD-ROM from the drive. 

20 Reboot the system.

21 Complete the procedures in the section entitled, "Execute Auto-Discovery" on 
page 81. 
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Upgrade DNM 2.0.1 and Later
This section contains the procedure to upgrade an existing DEFINITY Network 
Management (DNM) release 2.0.1 or later.  

Before installing an upgrade, check with the customer to:

1 Verify that the Solaris and HP-UX patches have been installed. If not, the 
customer must install the patches before the installer can install the 
DEFINITY Network Management product.

2 Verify that the existing Versant database has been backed up. If not, request 
the file name or device name needed to backup the database.

Required 
materials

Users need the following materials and information:

• Root login and password 

• Completed PA001 form

• File name or device name to backup the database 

• Directory path for Adobe Acrobat Reader, if already installed

• CD-ROM for DEFINITY Network Management Release 3.0
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Procedure Complete the procedure below to upgrade DEFINITY Network Management 2.0.1 
or later to the current release. Install the product on the NMS network server.

1 Close all windows and applications. Log off the network server.

2 Optional. Hook up the archive device to backup the database.

3 At the UNIX login prompt, log in as the root user:

• Type [root login]

• Press ENTER

4 At the Password prompt,

• Type [root password]

• Press ENTER

5 Insert the CD-ROM entitled, DEFINITY Network Management Release 3.0, 
into the CD-ROM drive and close the drive.

6 Some operating systems may automatically mount the CD-ROM. TO 
manually mount the CD-ROM, at the UNIX prompt, execute one of the 
options (a, b, or c) below :

a For the SOLARIS platform, the system automatically mounts the 
CD-ROM. If the CD-ROM fails to mount, then

– Type mountall

– Press ENTER

b For the HP-UX platform:

– Type mount  -r /dev/dsk/[device_name] /cdrom

– Press ENTER 
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c For the AIX platform:

– Type mount -vcdrfs -r /dev/cd0 /cdrom

– Press ENTER

7 Change to the CD-ROM directory. i.e. typically for the
SOLARIS platform: cd /cdrom/cdrom0

8 To change into DNM product directory:

• Type cd DNM

9 At the UNIX prompt, type the INSTALL command exactly as shown below:

• Type ./INSTALL 

• Press ENTER

Result: The system displays the prompt: Do you want to install 
DEFINITY Network Management 3.0 Software? [yes]

10 To install the DNM product, press ENTER

11 Backup the Database Prompt. The system displays a recommendation to 
backup the existing DEFINITY database. Then the system displays the 
prompt:

Would you like to backup the database at this time 
[yes]?

Execute one of the options (a or b) below:

a To backup the database,

– Press ENTER

– Complete steps 12 and 13
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b To skip backup:

– Type N (no)

– Press ENTER 

– Then go to step 14

12 The systems displays the prompt: 

Backup the DEFINITY database to what file or device 
(enter a complete path) [ ]?

To backup the database to a file or device,

• Type [file path or device path]

• Press ENTER

Result: The system displays the confirmation prompt: Are you sure you 
want to backup the database to [file path or device 
path]? [yes]?

13 Execute one of the options (a or b) below,

a To confirm the file or device path, 

– Press ENTER

– Go to step 14

b To re-enter the file or device path,

– Type N (no)

– Press ENTER

– Repeat steps 12 and 13

– Then go to step 14
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Result: The system lists the size of the database and the backup space 
required. Next, the system displays a grid that tracks the progress of 
the task. Next, the system displays the message below: 

Backup has completed successfully. 

14 Then the system displays the message and prompt below: 

During installation, the existing database can be 
upgraded or it can be removed and a new empty database 
created.

Continue with the existing database [yes]?

Execute one of the options (a or b) below:

a To upgrade the existing database, press ENTER

b To create a new, empty database, 

– Type N (no) 

– Press ENTER

15 Printer Command Prompt. The system displays a message that describes 
the print command. Then the system displays the prompt: 

Enter Printer Command [lp %file].

On the PA001 form, go to the Network Management System (NMS) section 
and refer to the Printer Command field.

At the UNIX prompt, execute one of the options (a or b) from the PA001 form:

a To accept the default printer command, press ENTER 
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b To enter the printer command from the PA001 form:

– Type [printer command]

– Press ENTER

16 Telnet Command Prompt. The system displays a message that describes 
access to a DEFINITY ECS switch through a telnet session to a Proxy Agent. 
When users execute a telnet session from the DNM product, the system 
appends the target host name to the telnet command string. Then the system 
displays the prompt: 

Enter Telnet command [xterm -e telnet]?

On the PA001 form, go to the Network Management System (NMS) section 
and refer to the Proxy Agent Telnet Command field.

Execute one of the options (a or b) below:

a To accept the default telnet command, press ENTER

b To enter a different telnet command, 

– Type the [command]

– Press ENTER

17 HTML Report Location Prompt. The system displays a message that 
describes access by a web browser to the HTML reports. Then the system 
displays the prompt: 

Enter URL [file:///opt/lucent/DEFINITY]?

On the PA001 form, go to the Network Management System (NMS) section 
and refer to the HTML Report Location field.
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At the UNIX prompt, execute one of the options (a, b, or c) from the PA001 
form: 

a To accept the default URL, file:///opt/lucent/DEFINITY, press ENTER 

b Enter the URL for a web server from the PA001 form:

18 Modifications Prompt. The system displays a message that describes the 
environment variables and the required modifications that the installation 
script needs to make.Then the system displays the prompt: 

Make the /etc/profile and CDE modifications? [yes]

To make the modifications, press ENTER

19 Adobe Acrobat Reader Prompt. The system displays a message that user 
documentation can be viewed by installing the Adobe Acrobat Reader or 
entering the directory if the reader is already installed. Then the system 
displays the prompt: 

Enter Adobe Acrobat Reader directory (leave blank to 
install): [ ]?

Execute one of the options (a or b) below:

a To install the Acrobat Reader, go to step 20

b If the Acrobat Reader is already installed, go to step 21

20 To install the Acrobat Reader, execute steps (a through e) below:

a At the prompt, press ENTER

Result: The system displays the prompt: Install default 
configuration, Acrobat Reader 3.01 for [platform 
and release]? [y]
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b To continue, press ENTER

Result: The system displays the Adobe Acrobat Reader script NOTICE TO 
USER. At the end of the notice, the system displays the prompt: 

Do you accept the terms and conditions of this 
license agreement?

c Read the notice. At the prompt,

– Type accept

– Press ENTER

Result: The system installs the Acrobat Reader. Then the system displays 
the confirmation prompt: 

Enter directory where Reader was just installed: 
[/opt/Acrobat3]?

d To confirm the directory, press ENTER

e Then go to step 22

21 If the Acrobat Reader is already installed, then execute steps (a through c) 
below:

a Enter the directory path where the Acrobat Reader resides:

– Type [directory path]

– Press ENTER

Result: The system displays a confirmation prompt:

Enter directory where Reader is installed: 
[directory path]?
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b To confirm the directory, press ENTER

c Then go to step 22

22 Continue the DNM Installation. The system displays the message: All 
prerequisites have been met, do you want to continue with 
the installation of DEFINITY Network Management 3.0 
Software for [platform and release number] [yes]?

To continue the DNM installation, press ENTER

Result: The system displays a series of messages that confirm the 
installation of the software files, database files, web-based reports, 
and the DNM online HELP documentation. This may take several 
minutes. Then the system displays the message: 

Please reboot the system now to complete the 
installation and automatically start the DEFINITY 
Network Management processes.

23 To return to the root (/) directory:

• Type cd /

• Press ENTER

24 Use the eject or umount commands to unmount the CD-ROM:

25 Remove the CD-ROM from the drive. 

26 Reboot the system.

27 Complete the procedures in the section entitled, "Execute Auto-Discovery" on 
page 81. 
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Upgrade Fault Management 1.4 and Earlier
To upgrade from DEFINITY G3 Fault Management 1.4 and earlier, installers must 
complete the upgrade tasks described below. 

The DEFINITY Network Management release 3.0 cannot be installed over Fault 
Management 1.4 and earlier. 

Upgrade Tasks

Installers should complete the upgrade tasks listed below:

1 Upgrade the operating system and platform to meet the requirements for 
DEFINITY Network Management 3.0. Refer to “"System Requirements" on 
page 35 and the vendor documentation.

2 Complete the “"Customer Pre-Installation Checklist" on page 43.

3 Install the appropriate "Operating System Patches" on page 44. 

4 Complete the procedure to "Remove Fault Management 1.4 and Earlier" on 
page 72.

5 Complete the "Installation Tasks Checklist" on page 47.

6 Complete the procedure to "Install the New DNM Product" on page 55.
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Remove Fault Management 1.4 and Earlier
Complete the procedure below to remove the Fault Management 1.4 and earlier 
products.

Required 
Materials

Users need the following materials and information:

• Root login and password 

• CD-ROM for DEFINITY G3 Fault Management Release 1.4 or earlier

Procedure 1 Close all windows and applications. Log off the network server.

2 At the UNIX login prompt, log in as the root user:

• Type [root login]

• Press ENTER

3 At the Password prompt:

• Type [root password]

• Press ENTER

4 Insert the CD-ROM entitled, DEFINITY G3 Fault Management 1.4 (or the 
CD-ROM for release that is currently installed), into the CD-ROM drive and 
close the drive.
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5 At the UNIX prompt, execute one of the options (a, b, or c) below to mount the 
CD-ROM on the appropriate platform:

a For the SOLARIS platform, the system automatically mounts the 
CD-ROM. If the CD-ROM fails to mount, then:

– Type mountall

– Press ENTER

b For the HP-UX platform:

– Type mount  -r /dev/dsk/[device_name] /cdrom

– Press ENTER 

c For the AIX platform:

– Type mount -vcdrfs -r /dev/cd0 /cdrom

– Press ENTER

Result: The system mounts the CD-ROM. This takes a few seconds, so wait 
until the LED light stops blinking. Then, the system displays the UNIX 
prompt.

6 At the UNIX prompt, change to the CD-ROM root directory. i.e. For the 
SOLARIS platform typically: cd /cdrom/cdrom0
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7 At the prompt, type the remove command:

• Type ./REMOVE_G3FM

• Press ENTER

Note: The above prompt is an example. The system will display the actual 
platform name and release number that is currently installed on the NMS.

8 To remove the product:

• Type Y (yes)

• Press ENTER

Result: The system displays the prompt: Are you sure you want to do 
this? [no]. 

9 To continue the removal process:

• Type Y (yes)

• Press ENTER

Result: The system displays a series of messages about the preserved 
programs, removing the Acrobat Reader, and logging off the system. 
This may take a few minutes.

Then the system displays the message: G3FM Application has 
been removed from your system.
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10 To return to the root (/) directory:

• Type cd /

• Press ENTER

11 Use the eject or umount commands to unmount the CD-ROM:

12 Remove the CD-ROM from the drive: 

• Type exit

• Press ENTER

Result: The system exits the root directory and displays the UNIX login 
prompt: login:

13 Complete the tasks and procedures below:

• "Customer Pre-Installation Checklist" on page 43

• "Install the New DNM Product" on page 55
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Installation Error Messages
During installation, the system may display the messages below. Execute the 
suggested to solution to correct the error. 

Message You must be root to run the DEFINITY Network Management Installation 
command.

Solution: Request root permissions from the system administrator.

Message [Operating System] [OpenView] [NetView] release not supported by this 
release of DEFINITY Network Management.

Solution:

a Upgrade the operating system and platform hardware. Refer to resources 
below:

• "System Requirements" on page 35 

• "Customer Pre-Installation Checklist" on page 43 

• Vendor installation documentation 

b Reinstall the DNM product
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Message DEFINITY Network Management Installation failed.

Solution:

a Ensure that the "Customer Pre-Installation Checklist" on page 43 has been 
completed successfully.

b View DNM Installation log: /var/dnminstall.log

c Reinstall the DNM product 
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Backup and Restore the Database
Only the system administrator or root user should execute the procedure to 
backup and restore the database. 

Users can execute the BackupDEF utility to backup the database during 
installation or at any time after the product is installed.

Users can execute the RestoreDEF utility to restore the database from the 
backup file or the archive device.

Required 
materials

Users need the following materials and information:

• Root login and password

• File name or device name to backup the database 

Procedure Complete the procedure below to backup and restore the database.

1 Close all windows and applications. 

2 Optional. Hook up the archive device to backup the database.

3 At the UNIX login prompt, log in as the root user:

• Type [root login]

• Press ENTER

4 At the Password prompt:

• Type [root password]

• Press ENTER
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5 Execute the shutdown command for the DNM product:

• Type ProcStartup -K

• Press ENTER

Result: The system displays the message: Shutdown successful.

6 Execute one of the options (a or b) below: 

a To backup the database: 

– Type BackupDEF [input_file_path] or [input_device_path]

– Press ENTER

Result: The system backs up the database and displays the messages 

Backup was completely successful.

Then, the system displays the prompt: Would you like to do 
another level of backup on database ‘DEFINITY’? 
[default = no]

b To restore the database:

– Type RestoreDEF [input_file_path] or [input_device_path]

– Press ENTER

Result: The system displays a series of messages, which takes several 
minutes. Then the system displays the prompt: 

During the roll forward, would you like to apply 
records from the database’s current log file in 
addition to any archived records? [default = yes]
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– At the prompt, type N (no) and press ENTER

Result: The system restores the database and displays the message: 

Restore was completely successful. 

Then, the system displays the prompt: Would you like to do 
another level of restore on database ‘DEFINITY’? 
[default = no]

7 At the prompt, answer “no” 

– Press ENTER

– Go to step 8

8 At the UNIX prompt, log off the system:

• Type exit

• Press ENTER

Result: The system displays the UNIX login prompt: login:
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Execute Auto-Discovery
The Auto-Discovery feature integrates the system data from the managed nodes 
into the Network Management System (NMS) integration application. 

Auto-Discovery creates and updates the icons and submaps from data received 
from the applications listed below:

• Proxy Agents that are connected to managed nodes 

• Trouble Trackers that are connected to legacy equipment 

Users must log in to the NMS network server and execute Auto-discovery through 
the NMS user interface.
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Log in to the NMS Desktop
To execute Auto-Discovery, users must first log in to the Desktop on the Network 
Management System (NMS) network server. 

Required 
materials

Users need the following materials and information:

• NMS system name (uname - n)

Procedure Complete the procedure below to log-in to the Desktop in either the OpenView or 
NetView platform.

1 In a UNIX console window, set up DNM environment:

• Type  . /etc/lucent/DEFINITY/ENV

• Press ENTER

Result: The system displays the UNIX prompt.

2 Start the NMS user interface:

a For OpenView: 
– Type $OV_BIN/ovw&

– Press ENTER

b For NetView:

– Type $OV_BIN/nv6000

– Press ENTER

3 Complete the appropriate procedure below:

• "Execute Auto-Discovery on Public Networks" on page 83 

• "Execute Auto-Discovery on Private Networks" on page 84 
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Execute Auto-Discovery on Public Networks
The procedure below is required to execute Auto-Discovery on the public 
networks. 

1 At the Root map, select one of the options (a or b) from the menu bar:

a On OpenView, click Fault > DEFINITY > Execute Auto-Discovery

b On NetView, click Monitor > DEFINITY > Execute Auto-Discovery

Result: The system executes Auto-Discovery and logs the events in the 
Events Categories window.

2 To view the events In the Events Categories window,

• Click All Events

• Scroll down the list to find the message: Auto-Discovery Completed 
Successfully.

3 If appropriate, complete the procedure to "Execute Auto-Discovery on Private 
Networks" on page 84

4 Verify that the DNM installation and the NMS integration were successful. 
Refer to Chapter 4, "Getting Started on DNM for UNIX". 
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Execute Auto-Discovery on Private Networks
The procedure in this section is optional. Users should execute the procedure 
only for private networks. 

For private networks, users must manually administer the fields in the Simple 
Network Management Protocol (SNMP) configuration file. Auto-Discovery uses 
these fields to access the SNMP data from the Proxy Agent.

Required 
materials

Users need the completed PA001 form. Refer to the Proxy Agent section and the 
fields listed below:

• Proxy Agent IP network address

• SNMP Get Community String 

• SNMP Set Community String 

Procedure Complete the procedure below to execute Auto-Discovery on private networks.

1 Access the SNMP Configuration window from the NMS user interface.

2 If selected, turn-off the button: USE PROXY TO ACCESS TARGET

3 On the PA001 form, go to the Proxy Agent section and refer to the Network 
Managers fields.

In the SNMP Configuration window, enter the data from the PA001 form in the 
fields below. Do not change any other fields:

• In the Target field, type [IP address] for the Proxy Agent

• In the Community String field, type  [private “get” name ] 

• In the Set Community String field, type [private “set” name ]
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• Click: ADD

• Click: OK

Result: The system updates the fields and displays the Root map.

4 At the Root map, select one of the options below from the menu bar:

a On OpenView, select Fault > DEFINITY > Execute Auto-Discovery

b On NetView, select Monitor > DEFINITY > Execute Auto-Discovery

Result: The system executes Auto-Discovery and logs the events in the 
Events Categories window.

5 To view the events In the Events Categories window,

• Click All Events

• Scroll down the list to find the message: Auto-Discovery Completed 
Successfully.

6 Verify that the DNM installation and the NMS integration were successful. 
Refer to Chapter 4, "Getting Started on DNM for UNIX". 
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Auto-Discovery Errors and Problems
This section contains typical Auto-Discovery errors messages and problems, as 
well as solutions to resolve the problems.  

Vendor 
documentation

Users should also refer to the vendor documentation to resolve hardware and 
software problems with:

• UNIX system

• SCO UnixWare operating system

• OpenView and NetView operating systems

• Sun Solaris platform

• HP-UX platform

• AIX platform

• Other hardware and software products from third-party vendors

Message Auto-Discovery currently in progress, current request ignored

Solutions: 

• Execute Auto-Discovery at a later time.

• Review the Applications Alert Event log and the Events Categories window to 
further troubleshoot events that may be related.
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Message Read Only Map - Auto-Discovery Terminated

Solutions: 

• Execute Auto-Discovery from a read-write submap.

• Review the Applications Alert Event log and the Events Categories window to 
further troubleshoot events that may be related.

Problem Auto-Discovery did not find a Proxy Agent. 

Cause: Auto-Discovery does not recognize the Proxy Agent as a SNMP managed 
node.

Solutions: Answer the questions below:

a Do you have permission to use Auto-Discovery? If not, see the system 
administrator.

b Is the Proxy Agent running? If not, start the Proxy Agent and execute 
Auto-Discovery.

c Is the Proxy Agent release 3.0? If not, Auto-Discovery does not recognize 
earlier releases.

d Is the Proxy Agent accessible from a node in the NMS seed file? If not, ask 
the system administrator to manually add the Proxy Agent. 

e Is the Proxy Agent in the IP Internet map structure for the Proxy Agent? If not, 
verify that the correct version of the Proxy agent product is installed and 
running on the Proxy Agent PC.

f Does the active submap have read/write permission? If not, open a different 
submap with read/write permissions.
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Problem A user deleted an icon, but Auto-Discovery keeps displaying the icon on the 
submap. 

Cause: The user did not delete the managed node from the Proxy Agent.

Solution: On the Proxy Agent, delete the node name from the Managed Node 
screen.

Problem A user administered the same managed node name on multiple Proxy 
Agents. However, NMS submap only shows the connection between the 
managed node and one of the Proxy Agents. 

Cause: Auto-Discovery can manage only one instance of a managed node name 
and disregards all but the last instance.

Solutions: 

a To administer one managed node on one Proxy Agent, delete the managed 
nodes from all but one Proxy Agent. 

b To administer the same managed node on multiple Proxy Agents, delete the 
managed node from all but one Proxy Agent. Then, rename the managed 
node to a different name each time you administer the managed node on 
multiple Proxy Agents.

Examples:

Denver 1 -- the original node name for a managed node on Agent 1

Denver 2 -- the same managed node, but renamed on Agent 2

Denver 3 -- the same managed node, but renamed on Agent 3
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Problem Icons display on the Root map instead of on submaps.

Causes:

• Auto-Discovery recognized a custom submap icon as a Root map 

or 

• The submap was removed or was never created

Solution: Use either of the solutions below to create a new submap:

a Use the Save Map command to make a copy of a similar submap. Then 
modify the new submap.

b Open a new submap at the right level, then:

– Move automatically-created icons to the new submap

– Create the appropriate custom icons

– Remove any custom-created icons that Auto-Discovery placed on the 
Root map

– Run Auto-Discovery to update the custom-made icons on the new 
submap.
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Remove the DNM Product
This section contains the procedure to remove the DEFINITY Network 
Management Release 3.0 for UNIX from the Network Management System 
(NMS) network server. 

Generally, the main reason to remove the software would be to restore data that 
has been lost or corrupted.

Remove 
command

For the DNM 3.0 release, the REMOVE command is added to the DNM command 
directory. Users can remove the DNM 3.0 product from the system without having 
to mount the DNM 3.0 product CD-ROM.

The REMOVE command deletes files that are essential to run the DNM product 
and preserves auxiliary software and files generated from the products.

The command deletes the files listed below:

• All executable files

• Configuration files

• Versant software and database

• Documentation files that are stored in the default directory 

• All product configuration data in the Network Management System (NMS) 
configuration and registration files

• SNMP configuration files for each Proxy Agent and the managed nodes

The command preserves the Adobe Acrobat Reader software.
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Required 
materials

Users need the following information and materials:

• Root login and password 

• File name or device name to backup the database 

Procedure Only the system administrator or root users should execute the procedure to 
remove the DEFINITY Network Management product. 

The remove script prompts you to backup the database to a file or an archive 
device. 

1 Close all windows and applications. Log off the network server.

2 Optional. Hook up the archive device to backup the database.

3 At the UNIX login prompt, log in as the root user:

• Type [root login]

• Press ENTER

4 At the Password prompt,

• Type [root password]

• Press ENTER

Result: The system displays the UNIX prompt.

5 In a Unix console window, set up DNM environment:

• Type  . /etc/lucent/DEFINITY/ENV

• Press ENTER

Result: The system displays the prompt: Do you want to remove the 
DEFINITY Network Management 3.0 software [no]?
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6 To remove the product,

• Type Y (yes)

• Press ENTER

Result: The system displays the prompt: Are you sure [yes]? 

7 To continue the removal process, press ENTER

8 Backup the Database Prompt. The system displays a recommendation to 
backup the existing DEFINITY database. Then the system displays the 
prompt:

Would you like to backup the database at this time 
[yes]?

Execute one of the options (a or b) below:

a To backup the database,

– Press ENTER

– Complete steps 9 and 10

b To remove the database,

– Type N (no)

– Press ENTER 

– Then go to step 11
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9 Backup File or Device Prompt. The systems displays the prompt: 

Backup the DEFINITY database to what file or device 
(enter a complete path) [ ]?

To backup the database to a file or device,

• Type [file path or device path]

• Press ENTER

Result: The system displays the confirmation prompt: Are you sure you 
want to backup the database to [file path or device 
path]? [yes]?

10 Execute one of the options (a or b) below,

a To confirm the file or device path, 

– Press ENTER

– Go to step 11

b To re-enter the file or device path,

– Type N (no)

– Press ENTER

– Repeat steps 9 and 10

– Then go to step 11

Result: The system lists the size of the database and the backup space 
required. Next, the system displays a grid that tracks the progress of 
the task. Next, the system displays the message below: 

Backup has completed successfully. 
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11 Then the system displays a series of messages that log the removal of the 
files from the system. 

Result: Finally, the system displays the prompt: DEFINITY Network 
Management 3.0 software has been removed from your 
system.

12 At the UNIX prompt, log off the system:

• Type exit

• Press ENTER

Result: The system exits the root directory and displays the UNIX login 
prompt: login:
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Introduction
Only the system administrator or root users should edit the files described in this 
section. 

The information allows system administrators to manage the options below:

• Control the NMSI polling of Proxy Agents

• Override the default location submaps that are administered on the Proxy 
Agent

• Execute system commands to start and stop the DNM product and to view the 
system health status

• Execute database commands

• Edit system configuration files to customize the DNM product

• Integrate third-party products for alarm notification

• Install the Auto-Discovery patch on Trouble Trackers 

Note: DEFINITY Network Management environment 
( . /etc/lucent/DEFINITY/ENV) should be set up before using any 
commands in this section. 
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System Location File
From the NMS workstation, system administrators can edit the Location file to: 

• Override the location submaps that are administered on Proxy Agents and 

• Set up locations for legacy systems that are managed by a Trouble Tracker

Location file To administer the Location file, edit the file:

• $OV_MAIN_PATH/OneVision/DG3Poll/Location

Format Each line in the Location file contains the format described below:

• System name

• White space <blank>

• Location 

– If generic, usa, custom, and legacy are entered in this line the NMSI 
places the system icon on the appropriate NMS map.

– If hide is entered in this line, the NMSI does not display the system icon 
on any map.

• White space <blank>

• One of the options below:

– State name if the Location is usa

– Custom name if the Location is custom

– Null string ("") if the Location is generic

• Enter double quotes ("") in any of the non-white space.
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The lines below are examples of valid entries in the lines:

• USA and State maps: defty1<tab>usa<blank>"Colorado"

• Custom map and custom name: defty2<tab>custom<tab>Africa

• Generic map: defty3<tab>generic<blank><blank>""

Any changes made in the Location file override the location submaps for the 
individual managed node (system name) that are administered on the Proxy 
Agent.
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System Commands
System administrators or root users can execute the commands in the sections 
below from the directory: $DNM_BIN_DIR

Start and Stop Commands
The DEFINITY Network Management processes normally start from UNIX inittab. 
The commands in the table below gives the system administration additional 
control of the DNM processes.

System administrators can view a log of system startups and shutdowns from:

$DNM_LOG_DIR/ProcMgr.log

Table 4. Start and Stop commands

Command Description

ProcStartup -K Stops the DNM system and prevents it from starting at 
system boot.

ProcStartup -r Restarts a stopped DNM system and enables it to start at 
system boot.
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System Health Commands
The table below contains the system health commands.

Table 5. System Health commands

Command Description

ProcStartup -s Prints process status 

ProcStartup -g Opens a graphical monitor of process status
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Database Commands
The table below contains the DNM backup and restore commands .

Table 6. Versant database commands

Command Description

BackupDEF A DNM command to back up the DEFINITY database to a 
file or archive device.

Refer to "Backup and Restore the Database" on page 78.

RestoreDEF A DNM command to restore the DEFINITY database from a 
file or archive device.

Refer to "Backup and Restore the Database" on page 78.
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System Configuration Files
The table below contains files that the system administrator can edit to 
customize the DEFINITY Network Management product. Any changes made to 
the files take effect when the system is restarted.

! CAUTION:
System administrators should back up these files before they edit them. 
Validation is not trivial.

• PMProp - Specifies the system properties: 

– DB parameters

– Port assignments

– SNMP parameters

– Print options 

– Others

• UserScripts - Identifies executable files to run when specified exceptions 
occur on the managed node
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Administer the Alarm Notification 
Only the system administrator or a root user who knows UNIX shell 
programming should edit the scripts to enable the alarm notification features.  

Script 
directories

The scripts reside in the directories below:

• $OV_MAIN_PATH/OneVision/bin

The bin  directory contains the sample scripts listed below:

• Definity_ARS

• AUDIX_ARS

• CMS_ARS

• CONVERSANT_ARS

• TT_ARS

Alarm 
notification 
options

System administrators can choose to use the pager or email features in the 
DEFINITY Network Management (DNM) product or edit the scripts to enable 
third-party products such as:

• Telemon, TeleAlert

• Remedy, Alarm Response Service (ARS)

! CAUTION:
Customers are solely responsible for the purchase, installation, and maintenance 
of third-party software products.
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Description of Alarm Notification Options
The tables below outline the alarm notification options that are available in the 
DNM product or from third-part vendors.

DNM options The table below contains the description of product options within the DEFINITY 
Network Management product. 

Table 7. DNM notification options

Option Description

CU Pager Pages the system administrator and sends a code that 
identifies the type of alarm, alert, or error received from the 
managed system.

Email Sends an email message to the system administrator that 
contains detailed information for the alarm, alert, or error 
received from the managed system.
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TeleAlert 
options

The table below contains the descriptions of the notification options in Telemon’s 
TeleAlert product.

Table 8. TeleAlert notification options

Option Description

Alpha Page Pages the system administrator and sends a code that 
identifies the type alarm, alert, or error received from the 
managed system. 

The alpha page also confirms that the system administrator 
received the page. The page repeats until the system 
administrator responds to the page.

Voice Page Sends a voice page to the system administrator and sends a 
code that identifies the type of alarm, alert, or error received 
from the managed system. 

The alpha page also confirms that the system administrator 
received the page. The page repeats until the system 
administrator responds to the page.

AUDIX Calls the system administrator’s AUDIX number and leaves 
a voice message that contains the detailed information for 
the alarm, alert, or error received from the managed system.
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Remedy ARS 
option

The table below contains the description of the notification option in Remedy’s 
ARS product. The sample script only supports ticketing. 

The Remedy ARS product supports voice page and email notification.

Table 9. Remedy ARS notification option

Option Description

Ticket Creates a trouble ticket that contains the historical 
information for the alarm, alert, or error received from the 
managed system. 
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Definity_ARS Script
The NMSI looks for the Definity_ARS script when one of the following events 
occur:

• NMSI receives an alarm trap from the managed nodes listed below:

– DEFINITY 

– MCU

• NMSI receives an exception event from the DNM application for these 
managed nodes

Then the NMSI calls the script and passes the values listed below to the alarm 
notification program. If a value is not defined, then the NMSI assigns the alarm 
the string "NULL_FIELD."

Alarm notification values:

1 System name

2 Error description

3 New status severity

4 Old status severity

5 Product ID

6 Alarm sequence number

7 Alarming Port 

8 Maintenance object name

9 On board fault

10 Type of alarm
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11 Alternate name for the device

12 Describes the external device

13 Product Identifier of external device

14 Building location of external device

15 Address of external device

16 Restart date time

17 Restart level

18 Restart carrier

19 Restart craft demand

20 Restart escalated

21 Restart interchange

22 Restart unavailable

23 Restart cause

24 Restart speA release

25 Restart speB release

26 Restart speA update

27 Restart speB update
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AUDIX_ARS Script
The NMSI looks for the AUDIX_ARS script when one of the following events occur:

• NMSI receives an alarm trap from the managed nodes listed below:

– DEFINITY Audix

– INTUITY Audix

– INTUITY Interchange

• NMSI receives an exception event from the DNM application for these 
managed nodes

Then the NMSI calls the script and passes the values listed below to the alarm 
notification program. If a value is not defined, then the NMSI assigns the alarm 
the string "NULL_FIELD."

Alarm notification values:

1 System name

2 Product ID

3 Alarm sequence number

4 Source of the alarm: 

• DEFINITY (for DEFINITY Audix)

• INTUITY

• INTERCHANGE

5 Error description

6 New status severity
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7 Old status severity

8 Alarm location

9 Alarm date

10 Alarm time

11 Resource

12 Fault code

13 Module ID

14 Event number

15 Count number

CMS_ARS Script
The NMSI looks for the CMS_ARS script when one of the following events occur:

• NMSI receives an alarm trap from the Call Management System (CMS)

• NMSI receives an exception event from the DNM application for the CMS

Then the NMSI calls the script and passes the values listed below to the alarm 
notification program. If a value is not defined, then the NMSI assigns the alarm 
the string "NULL_FIELD."
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Alarm notification values:

1 System name

2 Product ID

3 Alarm sequence

4 Error description

5 New status severity

6 Old status severity

7 Product type

8 Version

9 ID value

10 Number

11 Name

CONVERSANT_ARS Script
The NMSI looks for the CONVERSANT_ARS script when one of the following 
events occur:

• NMSI receives an alarm trap from the Conversant system

• NMSI receives an exception event from the DNM application for the 
Conversant system

Then the NMSI calls the script and passes the values listed below to the alarm 
notification program. If a value is not defined, then the NMSI assigns the alarm 
the string "NULL_FIELD."
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Alarm notification values:

1 System name

2 Product ID

3 alarm number

4 Error description

5 New status severity

6 Old status severity

7 Location

8 Date

9 Time

10 Resource

11 Fault code

12 Module ID

13 Event number

14 Count number
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Install the Auto-Discovery Patch on Trouble Tracker
The NMSI application contains the Auto-Discovery patch that allows you to 
monitor early releases of the Lucent legacy systems below from a Trouble 
Tracker:

• DEFINITY G1 and G2

• DIMENSION

• System 75 and 85

• Monitor 1

Only the system administrator or root user should execute the procedure to 
install the Auto-Discovery Patch on a Trouble Tracker.  

Auto-Discovery 
patch

The Auto-Discovery patch allows the NMSI to find the legacy systems that are 
connected to a Trouble Tracker and create the Lucent Legacy map on OpenView 
or NetView. When you execute the Auto-Discovery command, the NMSI updates 
the objects on the legacy map with the current alarm status. 

The NMSI also provides telnet access to the Trouble Tracker, where you can view 
alarm and error information for the legacy systems. 

You cannot view system or alarm data for legacy equipment from either the NMS 
legacy map or the DEFINITY Network Management (DNM) product.
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Auto-Discovery 
run time

The default run time for the Auto-Discovery patch is set for midnight. The run time 
for system maintenance or backup on the Trouble Tracker may also be set for 
midnight. 

If the run time for the Trouble Tracker is set for midnight, then change the run time 
for Auto-Discovery to a different time to avoid conflicts between the run times.

Required 
materials

You need the following materials and information:

• Trouble Tracker documentation 

• Trouble Tracker Root password

Procedure Complete the procedure below to:  

• Install the Auto-Discovery patch on the Trouble Tracker and 

• Change the default run time for Auto-Discovery (optional)  

The procedure does not contain all the steps for each task, but provides a 
guideline to complete the tasks.

1 At the UNIX prompt, use the ftp or rcp command to copy the TTautodisc file to 
the $TTASDIR on the Trouble Tracker.

The Auto-Discovery patch resides in file:
– $OV_MAIN_PATH/OneVision/bin 

Log-in to the Trouble Tracker as the ttas  user. 

Result: The system displays the Trouble Tracker main menu.
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2 To access the UNIX prompt,

• Type !sh

• Press ENTER

Result: The system displays a UNIX prompt.

3 At the prompt,

• Type ./TTautodisc -i 

• Press ENTER

Result: The system displays prompt for the root password.

4 At the Trouble Tracker prompt, 

• Type: [root password]

• Press ENTER

Result: The system displays the UNIX prompt.

5 At the prompt,

• Type ./TTautodisc

• Press ENTER

Result: The system access the file and then displays the UNIX prompt.

6 To exit the file,

• Type exit

• Press ENTER 

Result: The system configures the legacy equipment. Then, the system 
closes the file and displays the main Trouble Tracker main menu.
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7 Optional. Change the run time for Auto-Discovery.

From the Trouble Tracker main menu, escape to the UNIX shell,

• Type !sh 

• Press ENTER 

Result: The system displays the UNIX prompt.

8 At the prompt,

• Type crontab -l > /tmp/ct

• Press ENTER

Result: The system displays the UNIX prompt.

9 Use iv, or another editor, to edit the file and change the run time for 
Auto-Discovery.

Note: The systems displays time in the military (24-hour) format, with the minutes 
first, followed by the hour. For example: 00 24 indicates 12:00 midnight

• Type vi /tmp/ct

• Press ENTER

Result: The system displays the time in TTautodisc line: 00 24. 
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10 Edit the time on the TTautodisc line and type the new time in the military 
format, minutes first, without the brackets. Example: 30 04 (4:30 a.m.)

• Type [minutes] [hour]

• Press ENTER

• Press ESC to exit the edit mode

Result: The system displays the UNIX prompt.

11 At the UNIX prompt, re-register the new time, 

• Type crontab < /tmp/ct

• Press ENTER 

Result: The system displays the UNIX prompt.

• Type crontab -l

• Press ENTER

Result: The system updates the cron file. Then, the system displays the 
UNIX prompt.

12 Log-off the Trouble Tracker.

Result: The system displays the UNIX prompt.

13 Execute Auto-Discovery from the Trouble Tracker. 
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Introduction
This chapter describes the purpose and navigational instruction for the windows 
within the DEFINITY Network Management Release 3.0 application. In this 
chapter you will learn about the following windows and processes:

• Log in to DNM

• NMS maps

• Map commands

• DNM overview

• Online Help system

• DNM main window

• Access Applications

• Configuration

• Administration

• Report Scheduler

Note: To better view the graphics in this chapter, use your zoom tool. Most 
graphics are best viewed at 200%, but this may vary depending on your 
monitor screen size and resolution setting.
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Log in and Exit DNM
When users start DEFINITY Network Management, the system initiates the data 
refresh programs that update the system configuration and event information. The 
Network Management System (NMS) receives system configuration and 
management data from the Proxy Agents.

If DNM does not retrieve all of the data in an allotted time, then the system 
displays a message on the DNM main window and stops retrieving data. 

The system will start DNM with the existing cache data from prior DNM sessions, 
if available.

Procedure Complete the procedure below to log in and exit the DNM product and log off the 
NMS from the root map. 

1 At the UNIX login prompt:

• Type [login name]

• Press ENTER

2 At the Password prompt,

• Type [your password]

• Press ENTER

Result: The system displays the UNIX prompt.
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3 At the window prompt, execute one of the options (a, b or c) below:

a For OpenView on the Solaris platform, the system may display the 
prompt: Setup display: To determine the workstation name, 

– Type uname - n

– Press ENTER

Result: The system displays the workstation name. 

– Type DISPLAY=[workstation name]:0.0

– Press ENTER

– Type export DISPLAY

– Press ENTER

b For OpenView on the HP-UX platform,

– Type $OV_BIN/ovw&

– Press ENTER

c For NetView on the AIX platform,

– Type $OV_BIN/nv6000

– Press ENTER

Result: The system starts the Desktop and displays the Root map and 
Events Categories window.

4 At the Root map, double-click a DEFINITY icon.

Result: The system displays the submap for the selected system.
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5 On the submap, double-click an icon for a specific managed node.

Result: The system displays the DNM splash screen and the startup 
messages that track the time to complete the process. This may take 
several minutes. Then, the system displays the DNM main window 
and navigation tree for the system groups. 

6 To exit DEFINITY Network Management from the menu bar on any screen, 
click File > Exit

Result: The system exits the product and displays the Root map.

7 To log off the NMS,

• click File > Close

Result: The system displays the UNIX login prompt.
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Description of the NMS Maps
The Network Management System Integration (NMSI) program is one of the 
programs in the DEFINITY Network Management (DNM) software. The purpose 
of NMSI is to integrate the DNM product into the OpenView and NetView 
operating systems.

This integration allows users to monitor their Lucent telecommunication systems 
and data networks from the same workstation. 

NMS maps NMSI uses the Auto-Discovery program to find and transmit system data from the 
managed nodes (supported systems) to the NMSI programs. 

The NMSI uses the data received from Auto-Discovery to create and update the 
NMS maps, which include:

• NMS Root map

• DEFINITY map

• DEFINITY USA and State maps

• Custom maps 

The sections below describe the objects (system icons and connection lines) that 
display on the map and the color schemes that indicate the current status of the 
objects.
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Lucent Legacy 
map

NMSI also creates and updates the Lucent Legacy map if users installed the 
Auto-Discover patch on the Trouble Tracker. Refer to "Install the Auto-Discovery 
Patch on Trouble Tracker" on page 113 for more information.

The patch allows a Trouble Tracker to send SNMP traps to the NMS. The SNMP 
traps contain the names of the legacy systems and the current status of the 
systems. 

NMSI updates the Lucent Legacy map with the current status of the systems 
below:

• DEFINITY G1 and G2

• Audix 3.0 and earlier

• DIMENSION

• System 75 AND 85

• Monitor 1

Neither the DNM or the Proxy Agent products support the legacy systems. Users 
must telnet the Trouble Tracker to view the alarm and system data for the legacy 
systems. 
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Root Map
The root map on the Network Management System (NMS) is the initial user 
interface to the DEFINITY Network Management (DNM) product. The NMSI 
program creates additional maps and makes them subordinate to the root map. 

Proxy Agent 
submaps

NMSI places executable icons for the new maps on the root map. These icons 
represent the default location submaps that users administered on the Proxy 
Agent for the managed nodes. The submaps options include: Generic, USA and 
associated State maps, and Custom.

The icon names that display on the root map are:

• DEFINITY MAP identifies a Generic submap.

• DEFINITY USA MAP identifies the USA map and associated State supmaps.

• Any name that users assign to a Custom submap. Users can create many 
custom maps and assign different names for each map. The root map 
displays an individual icon for each custom submap.
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Legacy submap If users installed the Auto-Discovery patch on a Trouble Tracker during the DNM 
installation, then Auto-Discovery creates a legacy map. 

The icon name that displays on the root map is: "Lucent Legacy Map" on page 
134. 

The figure below shows the NMS root map with the executable icons that 
represent the submap types. Users can double-click the icon to open the NMS 
map.

Figure 2. NMS Root Map

1. DEFINITY Generic Submap icon 3. DEFINITY USA Submap icon

2. Lucent Legacy Submap icon 4. DEFINITY Custom Submap icon
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DEFINITY Map
In the figure below, the generic DEFINITY Map shows the Proxy Agent icons and 
connection lines to system icons for each supported managed node.

Figure 3. Generic Submap
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DEFINITY USA Map
The USA map displays executable system icons in the states where the managed 
nodes are located. The system icons on the USA map access the State map for 
the selected managed nodes.

The figure below shows the DEFINITY USA map and icons in different states.

Figure 4. DEFINITY USA map
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State Map
The figure below shows the State map with a Proxy Agent icon and a connection 
line to a system icon for the managed node located in that state.

Figure 5. State map
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Custom Map
Custom maps show Proxy Agent icon and connection lines to system icons for 
each supported managed node. Users can use create many custom maps with 
different names to organize the managed nodes by categories. 

The figure below shows a custom map with the system icon name in the title bar.

Figure 6. Custom Submap
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Lucent Legacy Map
The figure below shows the Lucent Legacy Map with a Trouble Tracker icon and 
connection lines to a legacy icon for each supported system. 

Figure 7. Legacy Submap
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System Icons
As shown in the figures above, the NMSI creates Proxy Agent icons and individual 
system icons for each managed node. The system icons identify the type of 
managed node that users administered on the Proxy Agent:

• DEFINITY G3 or ECS

• Multipoint Conferencing Unit (MCU)

• DEFINITY Audix

• INTUITY Audix

• INTUITY Interchange

• Call Management System (CMS)

• Conversant

The NMSI also creates a distinct system icon for DEFINITY Survivable Remote 
Processors (SRP). 

Connection Lines
Also shown in the figures above, the NMSI draws connection lines between the 
Proxy Agent icon and its supported system icons. The connection lines identify 
the type of connection between the Proxy Agent and the managed nodes:

• Solid line indicates a static connection

• Dashed line indicates a dynamic connection
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Root Map Colors
The default colors for the Network Management Systems, specifically OpenView 
and NetView, add color to the objects displayed on the Root map. The color 
indicates the current status of the objects. 

The table below contains the current status and the default color schemes for 
both OpenView and NetView. 

Table 10. Root map colors

Status OpenView Color NetView Color

Unknown Dark Blue Light Blue

Normal Green Green

Warning Light Blue Pink

Minor Yellow Yellow

Major Orange Orange

Critical Red Red
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NMS Colors
The Network Management System (NMS) adds additional colors to the system 
icons and connection lines on the maps listed below:

• DEFINITY Map

• DEFINITY USA Map and associated State maps

• Custom maps

DNM support DNM only supports SNMP traps and alarm traps from the Proxy Agent for the 
systems below: 

• DEFINITY G3 PBX release 4.0 and DEFINITY ECS releases 5.0 through 8.1

• Survivable Remote Processors (SRPs)

• Multipoint Conferencing Unit (MCU) release 5.0 through 6.0. 

DNM treats SRPs and MCUs as DEFINITY systems.

NMSI support The NMS Integration (NMSI) program on DNM only supports alarm traps from the 
Proxy Agent for the systems below:

• DEFINITY Audix releases 3.1 through 4.0

• INTUITY Audix release 4.3 through 5.0 (with or without the remote 
maintenance board)

• INTUITY Interchange release 5.1 through 5.3

• Call Management System (CMS) R3V6 through R3V8

• Conversant release 7.0

The DNM maps only provide telnet support to the products above.
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Legacy system 
support

If the Auto-Discovery patch is installed on a Trouble Tracker, then the Network 
Management (NMS) programs on OpenView and NetView only support alarm 
traps from Trouble Trackers that manage the Lucent legacy systems listed below:

• DEFINITY G1 and G2

• DIMENSION

• System 75 and 85

• Monitor 1

The DNM maps only provide telnet support to the Trouble Tracker.

The legacy system icons and Trouble Tracker connection lines display on the 
Lucent Legacy map.
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Proxy Agent 
icon colors

The table below contains the Proxy Agent icon colors that display on DNM maps. 
The colors indicate whether or not the Proxy Agent is responding to requests.

Table 11. Proxy Agent Object colors

Object OpenView Color NetView Color

Proxy Agent icon Dark Blue = Unknown. Proxy 
Agent is not responding

Green = Normal

Cyan = Warning. Proxy 
Agent is responding, but is 
not honoring SNMP 
requests. Indicates that the 
SMNP community string for 
the NMS is incorrect.

Red = Major. Proxy Agent 
failed to forward an alarm to 
INADS on its last try.

Cyan = Unknown. Proxy 
Agent is not responding

Green = Normal

Pink = Warning. Proxy Agent 
is responding, but is not 
honoring SNMP requests. 
Indicates that the SMNP 
community string for the 
NMS is incorrect.

Red = Major. Proxy Agent 
failed to forward an alarm to 
INADS on its last try.
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DEFINITY object 
colors

DNM maintains a list of active exceptions for the systems listed below:

• DEFINITY G3 and ECS

• Multipoint Conferencing Unit (MCU)

• Survivable Remote Processor (SRP)

DNM treats the MCUs and SRPs as DEFINITY systems.

The table below contains the DEFINITY icon colors and the Proxy Agent line 
connections that display on the DNM maps. 

Table 12. DEFINITY Object colors

Object OpenView Color NetView Color

DEFINITY icon

MCU

SRP

Dark Blue = Unknown. Proxy 
Agent is not responding

Green = Normal

Salmon = Dispatched

Cyan = Warning

Yellow = Minor

Orange = Major

Red = Critical 

Cyan = Unknown. Proxy 
Agent is not responding

Green = Normal

Lime Green = Dispatched

Pink = Warning 

Yellow = Minor

Orange = Major

Purple = Major

 (1 of 2)
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Other system 
object colors

The NMSI only supports alarm traps from the Proxy Agent for the systems below:

• DEFINITY Audix releases 3.1 through 4.0

• INTUITY Audix release 4.3 through 5.0 (with or without the remote 
maintenance board)

• INTUITY Interchange release 5.1 through 5.3

• Call Management System (CMS) R3V6 through R3V8

• Conversant release 7.0

The DNM maps only provide telnet support to the products above.

Line connections 
to DEFINITY icons

Black = Up

Red = Down or Other

Yellow = Init (initiating)

Cyan = Off

Salmon = Idle for dynamic 
connection

Black = Up

Red = Down or Other

Yellow = Init (initiating)

Cyan = Off

Green = Idle for dynamic 
connection

Table 12. DEFINITY Object colors

Object OpenView Color NetView Color

 (2 of 2)
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The table below contains the other system icon colors and the Proxy Agent line 
connections that display on the DNM maps. 

Table 13. Other system object colors

Object OpenView Color NetView Color

Other system icons 
for:

DEFINITY Audix

INTUITY Audix

Interchange

CMS

Conversant

Dark Blue = Unknown. Proxy 
Agent is not responding

Green = Normal

Salmon = Dispatched

Cyan = Warning

Yellow = Minor

Orange = Major

Cyan = Unknown. Proxy 
Agent is not responding

Green = Normal

Lime Green = Dispatched

Pink = Warning 

Yellow = Minor

Orange = Major

Line connections 
to other system 
icons

Black = Up. Proxy Agent is 
running and available to 
receive alarm traps.

Red = Proxy Agent is 
stopped and cannot receive 
alarm traps.

Black = Up. Proxy Agent is 
running and available to 
receive alarm traps.

Red = Proxy Agent is 
stopped and cannot receive 
alarm traps.
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Legacy system 
object colors

If the Auto-Discovery patch is installed on a Trouble Tracker, then the Network 
Management (NMS) programs on OpenView and NetView only support alarm 
traps from Trouble Trackers that manage the Lucent legacy systems listed below:

• DEFINITY G1 and G2

• DIMENSION

• System 75 and 85

• Monitor 1

The DNM maps only provide telnet support to the Trouble Tracker.

The table below contains the other Lucent Legacy system icon colors and the 
Trouble Tracker line connections that display on the Lucent Legacy map. 
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Table 14. Legacy system object colors

Object OpenView Color NetView Color

Lucent Legacy 
system icon

Dark Blue = Unknown. Proxy 
Agent is not responding

Green = Normal

Salmon = Dispatched

Cyan = Warning

Yellow = Minor

Orange = Major

Cyan = Unknown. Proxy 
Agent is not responding

Green = Normal

Lime Green = Dispatched

Pink = Warning 

Yellow = Minor

Orange = Major

Line connections 
to Lucent Legacy 
system icon

Black = Up. Proxy Agent is 
running and available to 
receive alarm traps.

Black = Up. Proxy Agent is 
running and available to 
receive alarm traps.
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Execute Commands from NMS Maps
The NMS Integration (NMSI) program allows users to execute various commands 
from any of the NMS maps. Most of the commands perform operations on the 
systems that display on the selected map.

Users can execute the commands in three ways:

• Select a command from a menu

• Double-click an object on the map

• Select objects from the third mouse button

The sections below explain the commands and the execution options.

Description of Commands
The table below lists the commands that users can execute from any NMS map. 
The Description column describes the result of the command.

Based on the result of the command, the NMSI updates the NMS maps, changes 
the color of the status, and displays the appropriate NMS and DNM windows.
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Table 15. NMS Map commands

Command Description

Network 
Management 
Application

(DNM product)

This command displays the DNM main window that contains 
the systems group navigation tree and configuration and 
status window. 

If users execute this command for a specific DEFINITY on 
the NMS map, then the command opens the DNM main 
window only for the selected DEFINITY.

Report Generator This command displays the Report Generator window in the 
DNM product.

Exception Report This command displays the results of a DNM Exception 
report. 

If users execute this command for a specific DEFINITY on 
the map, then the report shows exceptions only for the 
selected DEFINITY.

Lucent 
Technologies 
Documentation

This command opens the Adobe Acrobat Reader and 
displays the main menu. 

Users access the DNM User Documentation for UNIX (this 
book) and PA001 forms from the main menu.

 (1 of 5)
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Execute 
Auto-Discovery

This command instructs the NMSI to locate the Proxy 
Agents in the network. 

The NMSI interrogates the Proxy Agents for the current data 
from the managed nodes and updates the NMS maps.

Acknowledge Alert This command turns off alerting for a selected system icon 
and changes the color status to normal.

Set Alert to Minor This command sets the alert level to Minor for the managed 
nodes listed below:

• DEFINITY Audix

• INTUITY Audix

• INTUITY Interchange

• Call Management System (CMS)

• Conversant

• Trouble Tracker

• Lucent Legacy system 

Table 15. NMS Map commands

Command Description

 (2 of 5)
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Show Managed 
Nodes

This command displays the Managed Nodes list for a Proxy 
Agent. The list contains the current settings for all the 
managed nodes administered on the specific Proxy Agent, 
including:

• Node Type and Node Name

• Connection Type (static or dynamic), Connection 
Status, and Timeout minutes for dynamic connections

• Submap type

• Object Label which is the Node Name

Connection Status This command displays the Connection Status window for a 
DEFINITY, MCU, or Survivable Remote Processor (SRP). 
The title bar on the window contains the name of the 
managed node. 

The Connection Status list contains the information below:

• Connection Type (static or dynamic)

• Connection State (Up, Off, etc.)

• Counters for connection statistics

• Alarm Forward Status

Table 15. NMS Map commands

Command Description

 (3 of 5)
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Start Connection This command instructs the Proxy Agent to start a 
connection to a DEFINITY, MCU, or SRP. 

The NMSI sets the connection state to init (initiating), which 
signals the Proxy Agent to connect to the managed node. 
The NMSI also changes the color of the connection line to 
the init color to indicate the current status.

Stop Connection This command drops the connection between a Proxy Agent 
and a DEFINITY, MCU, or SRP. 

The NMSI sets the connection state to off, which signals the 
Proxy Agent to drop the connection. The NMSI changes the 
color of the connection line to warning or unknown. 

When the Proxy Agent drops the connection, NMSI again 
changes the color of the connection line to off. 

Telnet to Proxy 
Agent

This command displays the telnet window to the Proxy 
Agent. 

From the telnet window, users can log in to the Proxy Agent 
and initiate an emulation session to cut-through to the 
managed node.

Table 15. NMS Map commands

Command Description

 (4 of 5)
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Telnet to Trouble 
Tracker

This command displays the telnet window to the Trouble 
Tracker. 

From the telnet window, users can log in to the Trouble 
Tracker and initiate an emulation session to cut-through to 
the Lucent legacy system.

Refresh Alarms 
and Errors

This command retrieves the status of systems that have 
dynamic connections to the Proxy Agent. 

The NMSI request DNM to update exception data for alarms 
and errors for selected DEFINITY, MCU, and SRP systems. 
After DNM updates the alarm and error data, the NMSI 
updates the system icons on the NMS maps.

In addition, the NMSI adds an item called PBX MIB Values 
to the OpenView Fault menu and NetView Monitor menu.

• When users select a DEFINITY icon from a map and the 
PBX MIB Values from the menu, the NMSI displays a list 
of DEFINITY MIB groups. 

• When users select one of the DEFINITY MIB groups 
from the list, the NMSI displays the values of the objects 
in the MIB group for the selected DEFINITY.

Table 15. NMS Map commands

Command Description

 (5 of 5)
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Access Commands from the Menu Bar 
When users install the DNM product, the NMSI adds a DEFINITY submenu in the 
OpenView Fault and Performance menus and the NetView Monitor and 
Performance menus. 

Table The table below lists the command and indicates which menu contains the 
command. The table also indicates when the command is enabled.

Table 16. Access commands from the menu bar

Command Fault or 
Monitor Menu

Performance 
Menu

When enabled

Network Management 
Application 

(DNM product)

Yes Yes Always

Report Generator Yes Yes Always

Exception Report Yes Yes Always

Lucent Technologies 
Documentation

Yes Yes Always

Execute Auto-Discovery Yes Yes Always

Acknowledge Alert Yes No For any system icon, 
except DEFINITY, 
MCU, or SRP icons

 (1 of 3)
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Set Alert to Minor Yes No When any system icon 
is selected, except 
DEFINITY, MCU, or 
SRP icons

Show Managed Nodes Yes Yes When a Proxy Agent 
icon is selected 

Connection Status Yes Yes When a Proxy Agent 
connection line is 
selected for 
DEFINITY, MCU, or 
SRP icon

Start Connection Yes Yes When a Proxy Agent 
connection line is 
selected for 
DEFINITY, MCU, or 
SRP icon

Table 16. Access commands from the menu bar

Command Fault or 
Monitor Menu

Performance 
Menu

When enabled

 (2 of 3)
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Stop Connection Yes Yes When a Proxy Agent 
connection line is 
selected for 
DEFINITY, MCU, or 
SRP icon

Telnet to Proxy Agent Yes Yes When a Proxy Agent 
icon is selected 

Telnet to Trouble Tracker Yes Yes When a Trouble 
Tracker icon is 
selected

Refresh Alarms and 
Errors

Yes No When a DEFINITY, 
MCU, or SRP icon is 
selected

Table 16. Access commands from the menu bar

Command Fault or 
Monitor Menu

Performance 
Menu

When enabled

 (3 of 3)
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Procedure Complete the procedure below to execute a command from the menu bar. 

This procedure uses the Show Managed Nodes command as an example.

1 At an NMS map, click a Proxy Agent icon.

2 Execute the appropriate command (a or b) below from the menu bar:

a On OpenView, click Fault > Show Managed Nodes

b On NetView, click Monitor > Show Managed Nodes

Result: The system displays a window that contains the Managed Node List 
for the selected Proxy Agent.

3 To exit the window, click the Close button

Result: The system redisplays the NMS map.
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Access Commands from the Mouse Menu
For OpenView maps, the NMSI creates a menu on the button 3 mouse menu that 
allows users to access certain commands for objects on the NMS map. The 
objects include system icons and connection lines. 

The NetView maps do not provide this feature.

Table The table below shows the button 3 menu that is associated for each object on the 
NMS map.

Table 17. Access commands from the mouse menu

Object Commands on button 3 menu

Proxy Agent icon Show Managed Nodes

Telnet to Proxy Agent

Acknowledge Alert

Icons for:

DEFINITY 

MCU 

SRP

Network Management Application (DNM product)

Exception Report

Refresh Alarms and Errors

Telnet to Proxy Agent

Proxy Agent connection 
lines to: DEFINITY, MCU, 
and SRP icons

Connection Status

Start Connection

Stop Connection

 (1 of 2)
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Note: The button 3 menu does not contain commands for Proxy Agent 
connection lines to the system icons for DEFINITY Audix, INTUITY Audix, 
INTUITY Interchange, Call Management System (CMS), and Conversant.

The Proxy Agent only supports alarm traps from these systems and, 
therefore, does not collect system status or configuration data.

Icons for DEFINITY 
Audix, INTUITY Audix, 
INTUITY Interchange, 
CMS, and Conversant

Telnet to Proxy Agent

Acknowledge Alert

Set Alert to Minor

Trouble Tracker icon

Legacy systems icons

Telnet to Trouble Tracker

Acknowledge Alert

Set Alert to Minor

Table 17. Access commands from the mouse menu

Object Commands on button 3 menu

 (2 of 2)
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Procedure Complete the procedure to access commands on the button 3 menu. 

The procedures uses the Proxy Agent icon and Show Managed Nodes as an 
example.

1 At an NMS map on OpenView, click a Proxy Agent icon.

2 On the mouse, click button 3

Result: The system displays a window that contains the commands for the 
Proxy Agent icon: 

Show Managed Nodes

Telnet to Proxy Agent

Acknowledge Alert

3 In the window, click Show Managed Nodes

Result: The system displays a window that contains the Managed Node List 
for the selected Proxy Agent.

4 To exit the window, click the Close button

Result: The system redisplays the NMS map.
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Access Commands by Double-Clicking Objects
Users can also access a few commands by double-clicking certain objects 
(system icons and connections lines) on the NMS map. The NMSI displays only 
one command when users double-click an object. The table below contains the 
objects and the commands that are executed by double-clicking the object.

Note: Users can not access commands by double-clicking Proxy Agent 
connection lines to the system icons for: DEFINITY Audix, INTUITY Audix, 
INTUITY Interchange, Call Management System (CMS), and Conversant.

The Proxy Agent only supports alarm notification from these systems, and 
therefore, does not collect system status or configuration data.

Table 18. Access commands by double-clicking objects

Object Command

Icons for: DEFINITY, MCU, and SRP Network Management Application 

(DNM product)

Proxy Agent connection line to:

DEFINITY, MCU, and SRP

Connection Status

Icons for: Proxy Agent, Audix, 
Interchange, CMS, and Conversant

Telnet to Proxy Agent

Trouble Tracker icon

Legacy system icons

Telnet to Trouble Tracker



DNM-UNIX Release 3.0 User Documentation    

4 Getting Started on DNM for UNIX
DNM Graphical Overview

March 2000
Page 159

DNM Graphical Overview

Figure 8. DNM Graphical overview
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Online Help System
The online help system replaces the user guide for the DEFINITY Network 
Management product. 

The help screens contain the information listed below:

• Description and purpose of the screen 

• Procedure to complete appropriate tasks on the screen

• Links to Related topics for more information

Help menu The Help options on the menu bar contain the selections listed below:

• Help Topics -- Displays the Table of Contents that lists all of the help topics 
on the system. Users can also access the index to search for topics or 
keywords.

• Current Pane -- Displays the help topic for the current screen

• About DEFINITY Network Management 3.0 --Displays a window that 
contains the software version, date, and lists the applications that are 
installed.

Help button A Help button is also available on many tabs or panels in a window and on dialog 
screens. Help button displays a window that contains the help topic for the current 
screen.

Tip box A Tip box is designated with a light bulb and contains help information and 
guidelines for making selections on the current screen. The Tip box displays only 
on screens where additional information may be pertinent. 
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DNM Main Window and Navigation Tree
The DNM main window and navigation tree is the first window to display after the 
splash screen. You can access the DEFINITY Network Management application 
from the Windows Start Menu. The figure below is an example of the DNM main 
window.

Figure 9. DEFINITY Network Management main window
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Window 
components

The DNM main window is vertically split into two panes and opens to the systems 
root tree in the left pane and displays the systems Configuration and Status in 
the right pane.

• The left pane contains the navigation tree for the DNM application. The tree 
shows all nodes that are monitored or administered by DNM. The tree 
changes depending on the selection you make. 

• The right pane displays the detailed information for each node in the tree. 
You can view the information in a table or graphic format. The right pane is 
also referred to as the "display" pane.

• The splitter bar separates the left and right panes. You can drag the bar to 
increase or decrease the size of the panes.

• A scroll bar appears in each pane when the data in the panes exceed the 
viewing area.

• The menu bar spans both panes across the top of the window.

• The status bar spans both panes across the bottom of the window.

The display pane often shows either a table or graphic view of the component 
selected in the tree (left pane). You can toggle between the two views. 

Tree pane 
organization

The tree pane organizes the DEFINITY management information into a hierarchy 
of components. In the figure above, the tree nodes are organized by levels:

• The first level is the System Groups.

• The second level lists the Systems Group names.

• The third level list the system names within each Systems Group.

• The fourth level lists the components of the individual systems.
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Tree pane 
operation

You can expand and contract the levels of the tree nodes:

• The plus sign (+) indicates that the tree is contracted. To expand the node, 
click the plus sign.

• The minus sign (-) indicates that the tree is expanded. To contract the node, 
click the minus sign.

Alert icons The DNM tree node displays alert icons whenever an alert occurs on any of the 
system components. The alert icon changes color to indicate the highest alert 
severity on an individual component.

The alert icons display from the lowest level to the highest level on the tree. The 
higher levels on the tree display the alert icon for the highest alert severity for all 
components in the lower levels.

The shape and color of the alert icons indicate the severity of the alert:

Red star = Critical

Orange pentagon = Major

Yellow square = Minor

Cyan triangle = Warning

Blank area = Normal
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Menu Options The DNM Main Window contains the following menu options:

• File

– Administration: Opens the DNM Administration Window

– Report Manager: Opens the DNM Report Manager

– Exit: Exits the DNM application

• View

– Refresh: Refreshes the contents of the window if the displayed 
information has changed.

• Help

– Help Topics: Displays the Help Table of Contents

– Current Pane: Accesses help on the panel in the display pane

– About the DEFINITY Network Management: Displays information about 
the DNM application
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Configuration
The DNM Configuration windows are used to graphically display system 
configuration information from the DNM main window. From these windows you 
may browse managed nodes, their configuration, and administered properties.

Configuration 
Windows

• DNM Configuration Windows

• System Display 

• System Status Display

• System Group Graphic Display

• System Group Table Display

• Cabinet Display

• Detailed Cabinet Display

• Board Display

• Board Display-ATM

• Port Networks Display

• Port Network Display

• Port Network Connectivity Table - Center Stage Display

• Port Network Connectivity Graphical - Center Stage Display

• Switch Node Display

• Port Network Connectivity Tabular- Direct Connect

• Port Network Connectivity Graphical - Direct Connect

• Fiber Link Display
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• Port Network Connectivity Tabular - ATM

• Port Network Connectivity Graphical - ATM

• Port Network ATM Link Display

• Port Network Connectivity (PNC) - Status Display

• DCS Connectivity Display

• DCS Link Display

• Stations Display

• Data Modules Display

• Routing Patterns Display

• Routing Pattern Display

• Trunk Groups Display

• Trunk Group Display

• External Devices Display

• Bulletin Board Display

• Busyout/Release Results Display
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Command 
Buttons

The Configuration windows offer one or more of the following command buttons:

• Boards Displays the Board Report or Board for selected DEFINITY

• Busyout Sends the busy out command to the system for the selected board 

• Change ATM Displays a dialog box to set the ATM switch name

• Close Closes this window

• Details Displays for the selected system (default)

• Exceptions Displays all exceptions for the selected category

• Graphic View/Table View Toggle between the graphic and table data views

• Inventory Displays the Inventory Report for the selected category

• Refresh Alarms/Errors   Requests a refresh of alarm and error data

• Refresh Configuration   Requests a refresh of the configuration data

• Release Sends the release command to the system for the selected board

• Telnet ATM Displays a login dialog box for the ATM switch 

• Telnet Proxy Displays a login window for the Proxy Agent

• Update Requests a status update from the selected category



DNM-UNIX Release 3.0 User Documentation    

4 Getting Started on DNM for UNIX
System Group Table Display

March 2000
Page 168

System Group Table Display
When the DNM application is launched from the Start Menu, the display window 
opens to the System Group tabular display for the first defined system group.

DEFINITY Network Management 3.0 allows you to put DEFINITY’s into arbitrary 
groups. For example, you can group DEFINITY’s by geographical location, you 
can put DEFINITY’s that are in the same network into the same group, or you can 
group the DEFINITY’s according to who is responsible for managing them.

This table view displays the Configuration and Status window for the selected 
system group, provides an alert summary, and a configuration table as shown in 
the figure below. 
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Figure 10. System Group Display
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System Group Graphic Display
This window allows you to view a map of all DEFINITY’s within a chosen system 
group.

Figure 11. System Group Graphic Display
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This graphic view contains the following operational characteristics:

• Each icon is color-coded according to the most severe active exception on 
each DEFINITY. 

• For the selected DEFINITY icon on the map, you can access the DEFINITY 
component status display via a pull-down menu or mouse button. The choices 
in the pull-down menu will be the same as those available in the DEFINITY 
tree node. The pull-down menu also contains the following choices:

– System: displays the System Display for the selected system

– Telnet to Proxy: displays a login window for the Proxy Agent.

• You can access the DEFINITY configuration display by double-clicking on the 
desired DEFINITY icon.

• A DCS link between any two DEFINITYs indicates the signaling type (ISDN, 
X.25) and is color-coded for the most severe active exception on the link. The 
signaling type is indicated via a tool tip.

• You can access the DCS link display through a pop-up menu on a selected 
link between two DCS-connected DEFINITYs.

Note: Double-clicking on an icon defaults to the first item in the pull-down menu 
for that icon. Double-clicking on a link defaults to the fist item in the pop-up menu 
for that link.
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System Display
The System Display includes a listing of system components (such as Cabinets, 
Port Networks, Trunk Groups, and so on) and any corresponding alerts for the 
selected system.

Figure 12. System Display
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System Status Display
This window separates DEFINITY status data from the System Display. This 
window is used often as it provides information regarding occupancies, busied 
trunks/stations, and offers access to the most recent exceptions. 

Figure 13. System Status Display

Note: As current system status must be retrieved from the system, there will be a 
delay as you wait for the data.
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Cabinet Display
This window allows you to quickly locate a DEFINITY by providing specific layout, 
type, and building location as shown in the sample below.

Figure 14. Cabinets Display
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Detailed Cabinet Display

When the Details button is selected in the Cabinet Configuration and Status 
window, the Cabinet Configuration and Status Display appears with an attached 
cabinet graphic display or a board table display on the right side of the window.

You can toggle between the graphic and table displays via the Table View and 
Graphic View buttons in this window. The graphic display shows the location and 
type of each board in the selected Cabinet, and each board is colored to indicate 
its alert level. Board displays can be accessed from any board in the graphic 
display or in the board table. 

The Detailed Cabinet Display includes carrier information and board information 
such as the board type and total number of ports in addition to the alert summary 
and location information.
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Figure 15. Detailed Cabinet Tabular Display
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Figure 16. Detailed Cabinet Graphical Display
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Board Display
From the Cabinet display, any board (except an ATM trunk board) may be 
displayed as in the sample figure below. The Board Display shows the 
configuration information, an alert summary, and port information specific to the 
selected board.

Figure 17. Board Display

Note: The Busyout and Release buttons must be configured to correspond with 
the Proxy Agent.
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Board Display - ATM

The ATM Board Display provides board information such as board name and 
location, and circuit information including alert indicator, port number, trunk group 
number, and signaling group number.

Figure 18. Board Display ATM
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Port Display - General
The Port Display provides an alert summary for the selected port and port 
configuration information such as the location, board type, identifier, and second 
equipment type for the BRI port. The above information is included with specific 
data fields for the following windows:

• Port Display Station

– station: extension/type/name 

– location of: building/floor/room/cable/jack

– current service state: busy/sending/forwarding

• Port Display Trunk 

– trunk group: number/type/name/communications type/signaling type

– current service state

• Port Display Data Module

– data module: extension/type/name/call forwarding extension

– current service state

• Port Display External Device

– device: description/identifier/building/address/alarm level
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Figure 19. Port Display General
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Port Networks Display
The Port Networks Display shows a list of a DEFINITYs port networks and their 
locations.

Figure 20. Port Networks Display
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Port Network Display
The Port Network Display provides information for a selected port network.

Figure 21. Port Network Display
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Port Network Connectivity Table Display – Center Stage
Port Network Connectivity Table Display - Center Stage lets you view a 
DEFINITY’s port networks and switch nodes, and the connectivity between them.

Figure 22. Port Network Center Stage Connectivity Display
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Switch Node Display

The Switch Node Display provides alert counts for the selected switch node, the 
system name, type (DEFINITY, MCU, or SRP) and release, the switch node 
number, the PNC, carrier, location information, and board information.

Figure 23. Switch Node Display
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Port Network Connectivity Graphical Display – Center Stage
This window contains a graphical display of nodes for each port network.

Figure 24. Port Network Center Stage Connectivity Graphical Display

This window provides the following operational characteristics:
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• On a DEFINITY PNC map, DNM displays a node of each port network (PN), 
clearly distinguishing between processor port network (PPN) and expansion 
port network (EPN), and a port number label.

• For each port network on a PNC map, each node is color-coded according to 
the most severe active exception on that node.

• For a selected port network, you can access the Port Network Display via a 
pop-up menu.

• For a center-stage switch PNC, port networks (PNs), switch nodes (SNs), 
SN-to-SN links, and PN-to-SN links are shown. The link is labeled with the 
fiber link number.

• For a center-stage switch PNC, the link between the SN and PN shows when 
the port network number uses DS1 facilities via a tool tip.

• You can access the Switch Node Display via a pop-up menu on a switch node 
icon on the PNC map.

• You can access the Fiber Link Display via a pop-up menu on a link on the 
PNC map.

• Information such as location, DS1, or SRP, can be displayed via a tool tip 
when the cursor is placed on a port network icon or link.

Note: Double-clicking on an icon defaults to the first item in the pull-down menu 
for that icon. Double-clicking on a link defaults to the first item in the pop-up 
menu for that link.
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Port Network Connectivity Table Display – Direct Connect
The Port Network Connectivity Table Display – Direct Connect  shows the port 
networks and the links that connect them directly to one another. Information such 
as the fiber link number and the DS1 location is also provided in this window.

Figure 25. Port Network Connectivity Table Display - Direct Connect
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Fiber Link Display

The Fiber Link Display provides an alert summary for the selected fiber link and 
associated boards, fiber link configuration information including the first and 
second endpoint port network numbers or switch node numbers , and board 
information.

Figure 26. Fiber Link Display
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Port Network Connectivity Graphical Display – Direct Connect
This window contains a graphical display of nodes for each port network.

Figure 27. Port Network Direct Connect Graphical Display
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This window provides the following operational characteristics:

• On a DEFINITY PNC map, DNM displays a node of each port network (PN), 
clearly distinguishing between processor port network (PPN) and expansion 
port network (EPN), and a port number label.

• For each port network on a PNC map, each node is color-coded according to 
the most severe active exception on that node.

• For a selected port network, you can access the Port Network Display via a 
pop-up menu.

• For a direct-connect port network, the links are labeled with the fiber link 
numbers.

• You can access the Fiber Link Display via a pop-up menu on a link on the 
PNC map.

• Information such as location, DS1, or SRP, can be displayed via a tool tip 
when the cursor is placed on a port network icon or link.

Note: Note: Double-clicking on an icon defaults to the first item in the pull-down 
menu for that icon. Double-clicking on a link defaults to the first item in the 
pop-up menu for that link.
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Port Network Connectivity Table Display – ATM

The Port Network Connectivity and Status window provides connectivity 
information for the selected port network connection.

Figure 28. Port Network Connectivity Table Display - ATM
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Port Network ATM Link Display
The Port Network ATM Link Display provides information for the selected port 
network link.

Figure 29. Port Network ATM Link Display
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Port Network Connectivity Graphical Display – ATM
The Port Network Connectivity Graphical Display - ATM shows a graphical 
display of nodes for each port network.

Figure 30. Port Network ATM Connectivity Graphical Display
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This window provides the following operational characteristics:

• On a DEFINITY PNC map, DNM displays a node of each port network (PN), 
clearly distinguishing between processor port network (PPN) and expansion 
port network (EPN), and a port number label.

• For each port network on a PNC map, each node is color-coded according to 
the most severe active exception on that node.

• For a selected port network, you can access the Port Network Display via a 
pop-up menu.

• For ATM port network connectivity, DNM displays a symbol representing the 
ATM network and the ATM link labeled with the link number and ATM switch 
name.

• You can access the ATM port network link display by via a pop-up menu on an 
ATM link on the PNC map.

• You can Telnet to an ATM switch via a pop-up menu on an ATM switch icon.

• Information such as ATM switch name and SRP, can be displayed via a tool 
tip when the cursor is placed on a port network icon or link.

Note: Double-clicking on an icon defaults to the first item in the pull-down menu 
for that icon. Double-clicking on a link defaults to the first item in the pop-up 
menu for that link.
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PNC Status Display
The PNC Status Display includes information such as, flags on the system and 
PNC health.

Figure 31. PNC Status Display
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DCS Connectivity Display

The DCS Connectivity Display provides the DCS Connectivity configuration 
information, an alert indicator showing alert counts for all DCS components on the 
selected link, and DCS Links information.

Figure 32. DCS Connectivity Display
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DCS Link Display
The DCS Link Display provides DCS link configuration information, and trunk 
groups information.

Figure 33. DCS Link Display
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Stations with Exceptions Display

The Stations with Exceptions Display provides station information, an alert 
indicator showing alert counts for all stations with exceptions, and stations with 
exceptions information.

Figure 34. Stations with Exceptions DIsplay
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Data Modules Display

The Data Modules Display provides information including the system name, 
system type (DEFINITY, MCU, or SRP) and release, an alert indicator, and Data 
Modules configuration information.

Figure 35. Data Modules Display
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Routing Patterns Display

The Routing Patterns Display provides Routing patterns information including 
the system name, type (DEFINITY, MCU, or SRP) and release, an alert indicator, 
and Routing Patterns configuration information.

Figure 36. Routing Patterns Display
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Routing Pattern Display

The Routing Pattern Display focuses on the selected Routing Pattern. In 
addition to the information provided in Routing Patterns Display, this window also 
includes specific Trunk Groups configuration information.

Figure 37. Routing Pattern Display
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Trunk Groups Display

The Trunk Groups Display provides Trunk Groups information including the 
system name, system type (DEFINITY, MCU, or SRP) and release, a summed 
alert count, and Trunk Group configuration information.

Figure 38. Trunk Groups Configuration and Status Display
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Trunk Group Display

The Trunk Group Display focuses on the selected Trunk Group providing 
configuration information (including hold time for ACA), Alert summary 
information, and Trunks with Exceptions information.

Figure 39. Trunk Group Display
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External Devices Display

The External Devices Display provides External Devices information such as, 
system name, type (DEFINITY, MCU, or SRP) and release, alert counts for all 
external devices, and External Devices configuration information.

Figure 40. External Devices Display
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Busy Out/Release Results Display

The Busy Out Results or Busy Release Results Display summarizes the 
results of a busy out or release of a board or trunk group. 

Figure 41. Busy Out Results
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Bulletin Board Display

The Bulletin Board Display provides the message date and message text in 
table format.

Figure 42. BUlletin Board Display
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Report Manager
The DNM Report Manager Window is used to create, edit, run, and view system 
reports. It also includes a scheduling window to schedule reports to run 
automatically, and a window to create and edit trunk group lists.

The DNM Report Manager Window contains a Navigation Pane on the left and a 
Display pane on the right. 

The Navigation Pane displays the following tree structure:

Description of 
the Report 
Manager 
Window Panes

Report Manager

• Report Definitions: The Report Definitions displays a list of the currently 
defined reports and lets you create new reports and edit and delete existing 
reports.

• Scheduled Reports: The Scheduled Reports displays a list of the current 
report schedules and lets you edit and delete schedules.

• Trunk Group Lists: The Trunk Group Lists displays a list of the current trunk 
group lists for DNM, and lets you create, edit and delete new trunk group lists.

How to Access 
the DNM Report 
Manager

To Open the Report Manager:

• From the DNM Administration Window, select File > Report Manager.

• To select a report, highlight a row in the table.

To close the Report Manager:

• From the Report Manager Window, select File > Close.
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Figure 43. Reports Pane

The Report List shows a table with four columns:

1 An icon indicating alert level, if there is an active exception representing 
failure to run a scheduled report. See below under Task Scheduler.

2 Report name.

3 Report type, e.g. "Processor Occupancy".

4 Time scale, e.g. "Daily peaks" for performance, or "Active" for exceptions
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New Report Dialog

The New Report Dialog prompts you for the report type and name of a new report, 
and brings up the Report dialog shown below.

Figure 44. New Report Dialog

A selection list offers available report types. You must select one. The default is 
the first type in the list.
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Using the OK button will verify that the report name is unique, create a new report, 
close the New Report dialog, and bring up the Report dialog.

The Cancel button will close the dialog and discards any changes.

There are three main types of reports in the DNM Report Manager: 

– Performance Reports

– Exception Reports

– Board Reports. 

All reports have a list of fields or table columns to include in the report, and a 
specification of up to three columns to sort. They also have some features specific 
to each report. 

Exception Reports have a severity threshold and Performance Reports have a 
set of chart options for graphical output.
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Report Definition Dialog

The Report Definition Dialog box lets you specify properties of a report, and then 
save the report, run it, or schedule it to run at a later time.

Note: The the Report Definition Dialog box will vary depending on the type of 
report chosen. 

Buttons The following buttons are used in the Report Dialog:

• Save

– Writes the report properties to the database. This button is active for new 
reports that have not yet been saved, and for any report in which you 
have made a modification since the last read or write.

• Run Now

– Runs the report on demand. While the report is running a progress dialog 
will keep you informed of approximate percent completed, and offer a 
cancel button to interrupt report processing. An information dialog will 
report success if there is no other output to the screen. Failure to run the 
report will bring up a warning dialog describing the reason for the failure

• Schedule

– Brings up the Schedule dialog. The Schedule button creates a new 
scheduled task for the report definition under edit. To modify an existing 
schedule, go to the Scheduled Reports pane, select a task from the table, 
and open it.
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• Reset

– Resets the report definition to the most recently saved version in the 
database. If this is a new report that has not yet been saved, resets its 
initial defaults.

• Cancel

– Closes the window after warning you of unsaved changes.

• Help

– Brings up a help window describing the tab currently shown.



DNM-UNIX Release 3.0 User Documentation    

4 Getting Started on DNM for UNIX
Performance Report

March 2000
Page 214

Performance Report

Figure 45. Report Definition Dialog: Performance type: Systems Tab
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For the Performance Report, the Report Definition Dialog box contains seven 
tabs:

1 Systems tab -lets you select from a list of systems known to the DNM 
application.

2 Component Selection tab (for example:Trunk Group or Hunt Group) - lets 
you select from a list of subcomponent trunk groups corresponding to the 
previous choices made. This is not applicable to all report types.

3 Fields tab- lets you select from a list of data fields in the selected report type.

4 Sort tab -lets you specify the order of rows in a table.

5 Format tab- lets you configure chart or table output format for the report.

6 Time tab- lets you specify the interval the report should cover.

7 Destination tab- lets you specify where the report output will be sent.
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Exception Report

Figure 46. DEFINITY Exception Report Definition Dialog Types Tab
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For the Exception Report, the Report Definition Dialog box contains eight tabs:

1 Systems tab - allows you to select from a list of systems known to the DNM 
application.

2 Types tab - allows you to choose the types of Exceptions that you want to 
include in your report.

3 Location tab- lets you specify the location for the types of exceptions 
included in your report. (i.e. Hardware location or Switch node number)

4 Level tab - lets you select one of more alert levels for your exception report.

5 Fields tab - allows you to choose the data fields to include in your report.

6 Sort tab - allows you to choose how this information will be sorted.

7 Time tab ( Exception Report) - lets you choose current exceptions or history 
of exceptions.

8 Destination tab - allows you to choose the report output destination.

When defining an exception report for DEFINITY, use all eight tabs. When 
defining an exception report for DNM you will see only the following tabs:

– 1. Level tab

– 2. Fields tab

– 3. Sort tab

– 4. Time tab (Exception Report)

– 5. Destination tab
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Board Report

There are two types of Board Reports available:

– Board Report Dialog - allows you to specify properties of a Board report 
(for individual boards) and then save the report, run it, or schedule it to 
run at a later time.

– Board Inventory - shows counts of boards by type and board code and is 
identical to the Board Report except for the list of fields and the absence 
of a Board Type tab.

• For the Board report, the Report Definition Dialog box contains six tabs:

1 Systems tab

2 Location tab (Board Report) - lets you choose the location for the types 
of boards included in your report. (i.e. Port network number)

3 Board Type tab - asks you to choose to include/exclude information for:

– only boards with unassigned ports

– all boards

– types to be included

– codes to be included

4 Fields tab

5 Sort tab

6 Destination tab
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Figure 47. Board Report Location Tab
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Report Output Interface

The Report Output dialog is a file chooser that lists stored output of previous 
report runs, and allows you to open one file and view the output.

Figure 48. Report Output Dialog
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Trunk Group List Management

The Trunk Group List pane shows an overview of currently defined TG lists at all 
systems and allows you to edit, delete, and create new lists.

Figure 49. Trunk Group Lists Pane
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Task Scheduler
In DNM 3.0 the Task Scheduler is used to schedule reports.

The Schedule List shows an overview of currently scheduled tasks, and allows 
you to edit or delete schedules. An alert indicator shows an active Scheduled 
Report Failure exception. 

Figure 50. Schedule Pane
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Buttons • Reschedule: 

– Initialized with the properties of the selected task. This button is inactive 
unless a task is selected.   Equivalent to File->Open

• Delete:

– Removes the task from the schedule. This button is inactive unless a task 
is selected.   Equivalent to Edit->Delete.

• Help:

– Brings up a help window for the Schedule Pane.
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Schedule Dialog

The Schedule Dialog allows you to schedule a report for later execution, or to 
modify an existing report schedule. The Schedule Dialog consists of two tabs:

Schedule tab This tab allows you to specify the frequency and run times of a scheduled report.

Figure 51. Schedule Tab
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Start and Stop 
tab

This tab allows you to specify start and stop times between which a schedule is in 
effect.

Figure 52. Start and Stop Tab
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Administration
The DNM Administration Window provides you with the capability to view and 
change a number of parameter settings. The DNM Administration Window 
contains a Navigation pane on the left and a Display pane on the right.

Figure 53. DNM Main Window
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In the DNM Main Window, the DNM Administration window can be accessed from 
the File menu. 

The DNM Administration window allows you to configure the following types of 
data:

• Alarms and Errors

• Trunk Exceptions

• Configuration Collection

• Trunk Group Exceptions

• Performance Collection

• System Exceptions

• Processor Occupancy Exceptions

• System Groups

How to Open 
the DNM 
Administration 
Window

1 Select a node in the Navigation Pane.

2 Click File > Administration.
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System Exceptions
The System Exceptions panel is used to administer the number of days that all 
exception records are stored.

Figure 54. System Exceptions Panel
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There are two tabs in this panel:

• Collection Failure: Allows you to define actions to be taken when there is a 
collection failure.

• Report Failure: Allows you to define actions to be taken by the system when 
there is a scheduled report failure.

How to Open 
the System 
Exceptions 
Panel

1 Open the DNM Administration Window.

2 From the Navigation pane, select Administration > System Exceptions.

How to Set the 
System 
Exceptions 
Collection 
Failure

1 Open the System Exceptions panel.

2 Select the Collection Failure tab.

3 Set the following fields:

• Maximum number of days to store exception records: Enter the 
maximum number of days for storing exception records. Valid values are 
0-999. The default is 30 days. The maximum is 999 days.

Note: The longer the exception records are to be stored, the larger the database. 
Use this to manage the size of the database and lengths of time exception 
records are stored.

• Store Exception: check to store exception data.

• Alert: check to store the alert status.

• Severity: select the level of severity: critical, major, minor, warning. The 
default is minor.
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4 Click Save to save your changes or Reset to reset the fields to their previous 
values.

How to Set the 
System 
Exceptions 
Report Failure

1 Open the System Exceptions panel.

2 Select the Report Failure tab.

3 Set the following fields:

• Maximum number of days to store exception records: Enter the 
maximum number of days for storing exception records. Valid values are 
0-999. The default is 30 days. The maximum is 999 days.

Note: The longer the exception records are to be stored, the larger the database. 
Use this to manage the size of the database and lengths of time exception 
records are stored.

• Store Exception: check to store exception data.

• Alert: check to store the alert status.

• Severity: select the level of severity: critical, major, minor, warning. The 
default is minor.

4 Click Save to save your changes or Reset to reset the fields to their previous 
values.
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Configuration Collection
The Configuration Collection panel is used to set parameters for collecting 
configuration data. It contains two tabs, as follows:

Figure 55. Configuration Data Collection Panel
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– Frequency: Allows you to set configuration collection frequency 
parameters.

– Times: Allows you to set a schedule for collection of configuration data.

If you are viewing the Configuration Collection panel under the DEFINITY 
Parameters tree node, the following fields are also available:

– Collection on: sets whether or not configuration data collection is turned 
on. Check to turn on. Uncheck to turn off.

– Use default values: sets whether or not default values are used. Check 
to use default values.

– Use custom values: sets whether or not custom values are used. Check 
to use custom values.

How to Set 
Configuration 
Collection 
Frequency

1 From the Navigation Pane, select Configuration Collection.

2 Click the Frequency tab.

3 Set the frequency for collection of configuration data by selecting Daily or 
Weekly.

4 Click Save to save your changes or Reset to reset the fields to their previous 
values
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How to Set the 
Configuration 
Collection 
Times

1 From the Navigation Pane, select Configuration Collection.

2 Click the Times tab.

3 Set the schedule for collection of configuration data by filling in the following 
fields:

• Collection Start Minute: set the minute within the hour when 
configuration collection should start. Valid entries are 0-59. The default is 
30.

• Daily Collection Hour: set the hour in the day when the configuration 
collection should start. Valid entries are 0-23 (24 hr. format). The default is 
1.

• Weekly Collection Day: select the day during the week when the 
configuration collection should occur.

4 Click Save to save your changes or Reset to reset the fields to their previous 
values.
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Trunk Exceptions
The Trunk Exceptions panel is used to administer trunk exceptions.

Figure 56. Trunk Exceptions Panel

There are five tabs in this panel as follows:

– Lightly Used Trunks: Allows you to control the logging and alerting to be 
taken for lightly used trunk exceptions

– Trunk Outages: Allows you to control the logging and alerting to be taken 
for trunk outage exceptions
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– Holding Times: Allows you to control the logging and alerting to be taken 
for ACA referrals for long and short holding times

– Frequency: Allows you to control the logging and alerting to be taken for 
trunk collection frequency parameters, i.e. daily or weekly.

– Times: Allows you to control the logging and alerting to be taken for a 
schedule for collection of trunk exceptions, i.e. the minute of the hour or 
the hour of the day.

If you are viewing the Trunk Exceptions panel under the DEFINITY Parameters 
tree node, the following fields are also available:

– Collection on: sets whether or not trunk exception collection is turned on.

– Use default values: sets whether or not default values are used. 

– Use custom values: sets whether or not custom values are used. 

– ACA Status: an ACA status label indicates whether or not ACA is 
enabled on the selected system. If this is not turned on at the switch, the 
information will not be collected.

How to Set 
Trunk and 
Holding Time 
Exceptions

1 From the Navigation Pane, select Trunk Exceptions.

2 Click the appropriate tab to select the type of exception you wish to set:

• Lightly Used Trunks tab

• Trunk Outages tab

• Holding Times tab
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3 Configure the following fields:

• Store Exception: check to store exception data.

• Alert: check if you wish to be alerted when these exceptions occur.

• Severity: select the level of severity: critical, major, minor, warning.

4 Click Save to save your changes or Reset to reset the fields to their previous 
values.

How to Set the 
Trunk 
Exceptions 
Frequency and 
Times

1 From the Navigation Pane, select Trunk Exceptions.

2 Click the appropriate tab:

• Frequency tab.

• Times tab

3 For the Frequency tab: set the collection frequency as Daily or Hourly.

For the Times tab: Set the schedule for collection of trunk exceptions by filling 
in the following fields:

• Collection Start Minute: set the minute within the hour when trunk 
exception collection should start. Valid entries are 0-59. The default is 7.

• Daily Collection Hour: set the hour in the day when the trunk exception 
collection should start. Valid entries are 0-23 (24 hr. format). The default is 
1.

4 Click Save to save your changes or Reset to reset the fields to their previous 
values.
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Alarms and Errors
The Alarms and Errors panel is used to set parameters for alarms and errors.

Figure 57. Alarms and Errors Panel
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There are eight tabs in this panel as follows:

– Major Alarms: Allows you to set actions to be taken for major alarm 
exceptions

– Minor Alarms: Allows you to set actions to be taken for minor alarm 
exceptions

– Warning Alarms: Allows you to set actions to be taken for warning alarm 
exceptions

– Errors: Allows you to set actions to be taken for error exceptions

– Boards: Allows you to set actions to be taken for board conflict 
exceptions

– Restarts: Allows you to set actions to be taken for cold restart exceptions

– Frequency: Allows you to set actions to be taken for alarm and error 
collection frequency parameters

– Times: Allows you to set actions to be taken for a schedule for collection 
of alarm and error exceptions

If you are viewing the Alarms and Errors panel under the DEFINITY Parameters 
tree node, the following fields are also available:

– Collection on: controls whether or not alarms, errors, and restarts 
exception is turned on.

– Use default values: sets whether or not default values are used. Check 
to use default values.

– Use custom values: sets whether or not custom values are used. Check 
to use custom values.
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Performance Collection
The Performance Collection panel is used to set parameters for performance data 
collection.

Figure 58. Performance Data Collection Panel
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There are four tabs in this panel as follows:

– Collection Hours: Allows you to set the schedule for collection of 
performance data.

– Data Types: Allows you to select the types of performance data to be 
collected.

– Storage Limits: Allows you to set the storage limits for performance data 
that is collected.

– Times: Allows you to set when performance data is to be collected. 

If you are viewing the Performance Collection panel under the DEFINITY 
Parameters tree node, the following fields are also available:

– Collection on: sets whether or not performance collection is turned on. 
Check to turn on. Uncheck to turn off.

– Use default values: sets whether or not default values are used. Check 
to use default values.

– Use custom values: sets whether or not custom values are used. Check 
to use custom values.
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Processor Occupancy Exceptions
The Processor Occupancy Exceptions panel is used to log processor occupancy 
data.

Figure 59. Processor Occupancy Panel
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There are two versions of this panel. 

Note: The Thresholds for these screens are based on the call processing portion 
of the Processor Occupancy.

The Default Processor Occupancy Exception Panel contains three tabs as 
follows:

– G3r Threshold: Allows you to set call processing occupancy threshold 
parameters for G3r DEFINITY systems.

– Non-G3r Threshold: Allows you to set occupancy threshold parameters 
for Non-G3r DEFINITY systems. 

– Exception: Allows you to set how to administer processor occupancy 
exceptions.

The DEFINITY Processor Occupancy Exception Panel contains two tabs as 
follows:

– Exception: Allows you to set how to administer DEFINITY processor 
occupancy exceptions.

– Threshold: Allows you to set occupancy threshold parameters for 
DEFINITY systems.

If you are viewing the Processor Occupancy Exceptions panel under the 
DEFINITY Parameters tree node, the following fields are also available:

– Collection on: sets whether or not processor occupancy is turned on. 
Check to turn on. Uncheck to turn off.

– Use default values: sets whether or not default values are used. Check 
to use default values.

– Use custom values: sets whether or not custom values are used. Check 
to use custom values.
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Trunk Group Exceptions
The Trunk Group Exceptions panel is used to configure trunk group exceptions.

Figure 60. Trunk Group Exceptions Panel
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This window contains two tabs as follows:

– Exception tab: Allows you to set the fields for administering this type of 
exception. 

– Calculation tab: Allows you to set the fields for the traffic model and 
service objective to use.

If you are viewing the Trunk Group Exceptions panel under the DEFINITY 
Parameters tree node, there is a table display. The table contains a row for each 
non-wideband trunk group in the DEFINITY configuration. You can edit the rows in 
the table.
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System Groups
The System Groups Administration panel is used to set up and organize system 
groups.

Figure 61. System Group Administration
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By default, all systems belong to the Systems group. This panel lets you set up 
new system groups and move systems into different system groups. 

System Groups need to be set up such that all Distributed Communications 
Service (DCS) Nodes associated with a specific DCS network belong to a unique 
system group. If there is only a single DCS network being managed, systems can 
be left in the default systems group. If nodes are not DCS network connected, 
systems may be grouped according to your needs.

The System Groups Administration panel contains a list of systems and the 
corresponding group to which each system belongs.

How to Create a 
System Group

– From the System Group Administration panel, click the New Group 
button.

– The New Group dialog box is displayed.

– Enter a new system group name and click OK.

– In the System Group Administration panel, use the drop-down list to 
change the system group for a particular system.

– Click Save to save your changes or Reset to reset the fields to their 
previous values.
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